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1.1

Overview
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Downloader Pro is a simple but powerful utility for transferring digital images to your PC. Transfer
images at the touch of a button, renaming and storing them with the filename and directory names
you choose.
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Step 1 Set up Downloader Pro preferences to work the way you
want
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Step 2 Plug in your card reader or DCF compliant
camera..... Downloader Pro starts automatically...
Downloads your files automatically... and automatically
opens the application you set in Preferences.

Step 3 Browse / edit your images. It's that simple!
Example (left) shows files downloaded and displayed
automatically in BreezeBrowser Pro, the perfect
partner for Downloader Pro!
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Downloader Pro supports the downloading of JPEG images, raw files from most cameras and video
files. It does not support the downloading of the new HEIF image format used by iPhones, iPads and
recent high end Canon cameras.

Where to find more information
What's new in Downloader Pro v2.0?
This overview section of this help gives a quick overview of what Downloader Pro can do.
Please see the getting started section if you are new to Downloader Pro and would like help getting
started.
The section on preferences gives more detailed help in setting up Downloader Pro and the section
on making the most of Downloader Pro contains useful tips for more experienced users.
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If you need more help please visit the support pages on our website or the BreezeBrowser forum (this
covers all of our products including BreezeBrowser Pro and Downloader Pro).
Downloader Pro release notes

1.1.1

What's new in Downloader Pro v2.0?
Thumbnail display
When using a card reader images to be downloaded can be displayed as large or small thumbnails.
The thumbnail display can be selected from the view menu or by typing Ctrl+T (small thumbnails) or
Ctrl+X (large thumbnails).

© 2022 Breeze Systems Limited

6

Downloader Pro Help

The first line of the thumbnail caption shows the image number, filename and file size. The second
line shows the date and time the photo was taken. The third line shows the download status and the
bottom line shows the download path.
Each thumbnail may represent one or more files to download e.g. Canon CRW raw files and their
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associated THM thumbnail files are shown as a single thumbnail.
Please note thumbnails cannot be displayed when downloading directly from a Canon camera using a
USB or FireWire cable.

Support for IPTC XMP data
Downloader Pro v2.0 supports the new IPTC XMP standard as used by BreezeBrowser Pro, Adobe
Photoshop and other imaging applications. XMP data is added directly to JPEG, TIFF and DNG files
and is stored in XMP "sidecar" files for other raw file formats.

Date based job codes
Downloader Pro v2.0 now supports date based job codes. This makes it much easier to download
memory cards which span several days and subjects. The image date selector can be displayed by
typing Ctrl+Tab or by selecting it from the View menu. One or more dates can be selected from the
list (hold the Control key down and click on dates to add them to the selection). When you click on a
date the images taken on that date are also selected to make it easier to identify the pictures. Right
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click on the date to display a menu of options for selecting dates and editing the job code.
Downloader Pro saves the job codes from the last 60 days so that they may be used next time it is
run. This feature can be enabled or disabled in preferences.
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New token style
Tokens are now enclosed in curly brackets (aka braces) e.g. {a} replaces %a
When Downloader Pro v2.0 is run for the first time it will check for a previous release and
automatically convert all the tokens to the new format. Downloader Pro saves its settings separately
from previous releases and so you can safely run old and new versions.

New sequence numbering
Now supports the continuous numbering of images using the tokens {seq#}, {seq#2}, {seq#3},
{seq#4}, {seq#5}, {seq#6}. This token allocates sequence numbers to images in timestamp order and
will continue numbering from the number of the last image downloaded the next time Downloader Pro
is run. The starting number can be reset or set to any required starting value in preferences.

GPS Geo-tagging
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Automatically store GPS location data in images as they are downloaded using track log data from
devices such as the Sony GPS-CS1. Please see the section on GPS Geo-tagging for details.

Backup plug-in extended
The backup plug-in has been extended to allow images to be automatically backed up to two
separate locations

1.1.2

Automatic folder naming
Use the folder renaming option to automatically organize your images as you download them:
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In the example above the source images are in three separate folders on the memory card and are
downloaded to a single folder named with the date the pictures were taken and the subject. The
subject can be entered using the "Job code" which can be setup to prompt you every time
downloader is run:

© 2022 Breeze Systems Limited

Introduction

13

For this example the download directory was set to "C:\Photos\{Y}-{m}-{D} {J}"
{Y}-{m}-{D} expands to the year, month and day the photo was taken and {J} expands to whatever
was entered for the job code.
See Download Preferences for details.
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Automatic file naming
Downloader can automatically rename the images from the short eight character names written by
the camera to something more meaningful. In the example below the filenames were specified as
"{Y}-{m}-{D} {J} {H}{M}{S}" to give the date the photo was taken followed by the subject (the job code
entered above) and the time the photo was taken:

© 2022 Breeze Systems Limited

Introduction

15

See Download Preferences for details

1.1.4

JPEG rotation
More and more digital cameras have an orientation sensor which detects whether a shot is taken in
vertical or horizontal format. The camera stores this information in the EXIF shooting data but
unfortunately most applications ignore this data and won't display the image correctly rotated.
Downloader can automatically rotate these images without any loss of quality so that they are
correctly displayed on your PC.
See General Preferences for details
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1.1.5

IPTC/XMP data entry
IPTC/XMP data is a method of storing textual information in images such as location, keywords,
copyright information and captions. Downloader Pro can automatically add this information to images
as they are downloaded. This is a big time saver for professional photographers who need to enter
IPTC data before submitting images to newspapers and magazines but is also useful to other
photographers who wish to record location and other information in their images.
Downloader Pro supports the current Adobe XMP format for storing IPTC data which either stores the
data in the image file (e.g. for JPEGs and TIFFs) or uses an XMP sidecar file (e.g. for raw files).
Downloader Pro can also optionally store a subset of the IPTC data in the older IPTC IIM format.
See the IPTC/XMP data page for details.

© 2022 Breeze Systems Limited

Introduction

1.1.6

17

Plug-ins to extend Downloader's functionality
Downloader has a plug-in interface which allows additional operations to be applied to images as they
are downloaded. Downloader ships with three plug-ins:
1.
2.
3.
4.

JPEG auto profile - automatically embeds a color profile in JPEGs according to the camera
model
JPEG resolution - automatically sets the resolution to a user defined DPI or dots/cm value
making it easier to set the print size in applications like Adobe Photoshop
Directory Maker - creates empty directories to support your workflow e.g. in addition to the
download directory this plug-in can create directories called working, finished, edited, web etc.
Backup - automatically copies downloaded files to a second destination e.g. a separate external
hard disk.

See the Plug-ins page for details
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Support for external storage devices
Downloader supports the downloading of images from external storage devices such as the NixVue
Vista and Delkin PicturePad. It automatically scans the disk to detect duplicate files and will only
download one copy of each file. Downloader also has display options to hide files that have already
been downloaded and duplicates to make it easier to see the files that need downloading.

1.2

Getting started
If you are using a card reader
Quickstart guide

If you are downloading directly from a camera
Downloading from a camera

The Main Screen
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Description of Downloader Pro's main window

More information
Overview of Downloader Pro
Using filename and directory tokens to automatically specify the download directory and rename files
as they are downloaded
Making the most of Downloader Pro

Automating your workflow
Automatically downloading images when Downloader Pro is run
Launching other apps to view your images after downloading

1.2.1

Quickstart fGuide
Follow the instructions below to setup Downloader Pro so that it runs automatically when a memory
card is inserted in your card reader:
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1.

Install Downloader Pro

2.

Plug-in your card reader to your PC if it isn't already connected and then insert a memory card
containing some images. A dialog similar to the one below will be displayed:
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3.

Click on the "Download images" camera icon and then click OK to launch Downloader Pro to
download your images. Downloader Pro will run and display a window similar to the one below:
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4.

Click on the Download button to start downloading the images. The images will be copied to the
directory shown in the "Download path" column (D:\2006-02-13\Windermere for photos taken on
13th February 2006 in the example above).
The download progress dialog will be displayed:
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5.

Click on the Close button to dismiss the download progress dialog when the download has
finished. Your images are now on your PC's hard disk and ready for editing or viewing. Now
either click on Delete button to delete the images from the memory card or the Close button to
exit Downloader Pro.

Further information
To find out more about specifying which directory and filename photos are stored under see Using
filename and directory tokens.
The section on "Making the most of Downloader Pro" contains useful hints and tips on setting up
Downloader Pro.

1.2.2

The main screen
The main screen lists the image files in the camera or card reader together with their size, date,
status and their download directory on the computer. The images to be downloaded can be displayed
as large or small thumbnails or as a list as shown in the screenshots below. The different views can
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Small thumbnails

The first line of the thumbnail caption shows the image number, filename and file size. The second
line shows the date and time the photo was taken. The third line shows the download status and the
bottom line shows the download path.
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Each thumbnail may represent one or more files to download e.g. Canon CRW raw files and their
associated THM thumbnail files are shown as a single thumbnail.
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In the list view the order in which the files are displayed can be changed by clicking on the column
heading of the list.
The status is one of the following:
Status
Downloaded
New file
Size different
Time different

Description
A file of the same name, size and timestamp is in the download directory
(i.e. it has probably been downloaded already). It will not be overwritten
when "Download" is pressed.
No file of that name exists in the download directory. The file will be
downloaded to the download directory when "Download" is pressed.
A file of the same name but with a different size is in the download directory.
This probably means that the file has already been downloaded and has
been edited. It will not be overwritten when "Download" is pressed.
A file of the same name and size but with a different timestamp is in the
directory. This probably means that the file has already been downloaded
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but has been changed in some way. It will not be overwritten when
"Download" is pressed.
Two or more source files of the same name and download path exist and
appear to be identical copies. This can happen when transferring a memory
card more than once to an external storage device such as the PicturePad or
MindStor. Only one copy of the file will be download.
Two or more source files of the same name and download path exist but
differ in size, date or other attributes. These files will not be downloaded or
deleted by Downloader.

Press "Download" to download all files with status "New file" or "Duplicate" to the download directory.
To change the program's settings, including the download directory, display the Preferences dialog by
clicking on the File menu and selecting "Preferences...".
Normally Downloader will download all files that need downloading. To download selected files only
simply select the required files in the list and press the "Download" button and a prompt will be
displayed asking whether you want to download the selected images or all the images.
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Press "Delete" to delete downloaded files from the camera. Normally Downloader will delete all files
that have been successfully downloaded. To delete selected files only simply select the required files
in the list and press the "Delete" button and a prompt will be displayed asking whether you want to
delete the selected images or all the images.
Note: Downloader will only delete files which have been downloaded to the computer and have the
same date/time and file size as the files stored on the camera.
You can specify the download directory and optionally rename image files as they are downloaded.
Please see Preferences for more details.
The "BreezeBrowser Pro" button shown above is a custom button which can be set to any caption you
like and setup to launch an application of your choice (see the Custom Button section for more
details).
All settings are stored when the program exits and are restored the next time it is run.
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A more detailed description of a file's download status can be displayed by right clicking on its name
in the list and selecting "Download status" from the menu.

1.2.3

Using filename and directory tokens
Filename and directory tokens are used to include information such as the date or time a picture was
taken to specify the download directory and filename. Each token is enclosed by curly brackets (aka
braces) e.g. {d}.
The easiest way to explain this is to use and example. Let's suppose you wish to download all your
images to a directory called Photos on your main hard disk, the C: drive without renaming the
images. To do this you would go to Preferences (click on the File menu and select Preferences) and
set the download directory to C:\Photos and the filename to {o} a shown below:
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The {o} for the filename means "use the original filename written by the camera" e.g. IMG_3426.JPG.
This simple setup is OK but all your photos would be stored in the same directory and as you take
more pictures it would soon become difficult to find the picture you want. A better solution would be to
store your photos in different directories according to when they were taken for example a separate
directory for each year and month. You can do this by setting the download directory to
C:\Photos\{Y}\{m}. The {Y} will be set to the year the picture was taken, e.g. 2006, and {m} is set to
the month e.g. 11 for pictures taken in November.
Now when you download your photos they will be automatically stored in the appropriate directory
according to the date when they were taken.
e.g. photos taken in November 2006 will be stored in C:\Photos\2006\11 and photos taken in
December 2006 will be stored in C:\Photos\2006\12.
If you take a lot of photos you might prefer to store each day's photos in a separate directory e.g. by
setting the download directory to C:\Photos\{Y}\{Y}-{m}-{D}. This would store photos in directories like:
C:\Photos\2004\2006-12-30
(photos taken on December 30, 2006)
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C:\Photos\2004\2006-12-31
C:\Photos\2005\2007-01-01

(photos taken on December 31, 2006)
(photos taken on January 1, 2007)

Note: It is a good idea to specify dates in the order year, month, day so that when a directories are
displayed in your image browser in alphabetical order they will also be in chronological order.
You can use the same technique with the filenames. The filenames given by the camera aren't
particularly useful e.g. IMG_0123.JPG, IMG_0124.JPG. The "IMG_" prefix is the same for all images
and doesn't contain any useful information. You could replace this with the time the picture was taken
so that you can tell when a picture was taken just by looking at its filename. To do this set the
filename to {t}_{r}. {t} will be set to the time the picture was taken in the form HHMMSS (e.g. 191500
for exactly 7:15pm). {r} is set to the four digit image number.
Press the "Show tokens..." button to display a list of the available tokens and their values for the
example file:
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Please see the Download path section for more details and suggestions for setting up your download
path.
A complete list of the tokens that can be used for filenames and directories can be found here.

1.2.4

Displaying thumbnails and playing WAV and AVI files
Double click on an image to display a thumbnail image and shooting data summary of a file (or right
click on the image and select "Show thumbnail"):
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Click on the "<< Prev" and "Next >>" buttons or use the cursor keys to step through other images.
Double click on a sound annotation file (WAV) or video movie (AVI) to play it in whatever application
has been registered with Windows to handle the files (normally Windows Media Player).
Note: Thumbnail display and the playing of AVI and WAV files is only available when downloading
from a card reader.

1.2.5

Downloading from a camera
Downloader can download directly from Canon EOS cameras and older Canon PowerShot cameras.
Please install the appropriate Canon USB drivers first. The latest drivers can be downloaded from
www.powershot.com. Then run Downloader and go to Preferences (by typing Ctrl+P or selecting
preferences from the File menu). Click on the "General" tab, set the image source to "Auto-detect" or
"Camera". Connect you camera to the USB or FireWire cable and then press F5 in Downloader to
connect and list the files to be downloaded. Some camera models auto-detect the USB connection
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and powerup in PC transfer mode. Other models have to be turned on manually and may also need
to be set to PC transfer mode.
Downloader can also download images directly from some cameras via a USB or FireWire
connection. Some cameras, e.g. Nikon cameras, appear as a drive letter when connected to your PC.
If you have a camera that works this way you can download from it as if it is a card reader.

1.2.6

GPS Geo-Tagging
Introduction
Geo-tagging is the writing of geographical information in image files. Downloader Pro can
automatically geo-tag JPEG and raw files by storing positional information in the form of latitude and
longitude read from track log data from a GPS device. This information is written to the standard
EXIF GPS shooting data stored in JPEG files and in the XMP sidecar file for raw files and can be
read by image browsers such as BreezeBrowser Pro.
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Many handheld GPS devices can store a track log which can be downloaded to a PC. The track log
contains both positional data in the form of latitude and longitude and the time in UTC (aka GMT).
Downloader Pro is able to read the track log data and the time each picture was taken and use this to
calculate where the picture was taken. It is important that the camera's clock is set accurately in order
for this to work.
Some GPS devices such as the Sony GPS-CS1 GPS Tracker are designed specifically for
photography and are very convenient to use with Downloader Pro. The Sony device is simply turned
on before you start taking pictures and automatically logs your position every 15 seconds. When you
download your photos you connect the GPS Tracker to your computer using a USB cable and
Downloader Pro will automatically read the track logs and store the latitude and longitude in your files
as they are downloaded. It can also optionally create a track log file which can be viewed in Google
Earth or Google Maps.
With other GPS devices it may be necessary to download the track logs to your PC before
downloading your images. Many GPS devices simply appear as a removable drive when connected
to a PC using a USB cable and can be accessed directly by using the "Search removable drives
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option". Please consult the manual for your GPS device for information on how to download the track
log to your PC.
Downloader Pro is able to read track log files in NMEA format with a .log or .nmea file extension or
GPX files with a .gpx or .xml file extension. The free GPSBabel utility can be used to convert
between many different GPS formats if your GPS isn't able to store track log data in NMEA or GPX
format.

Setup
Select "GPS settings..." from the Edit menu in Downloader Pro to enable and setup GPS geotagging.
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Place Names Lookup
When "Lookup place names using www.geonames.org is selected Downloader Pro will connect to the
internet to lookup the place name and other information using the latitude and longitude for the
image. You also need to provide your Geonames username when using the Geonames service. You
can create an account by visiting the Geonames website: www.geonames.org
This information is stored in the tokens shown in the example below and can be used to automatically
add place name data to the IPTC/XMP data.
Token
{geonames_name}
{geonames_countryName}
{geonames_adminName1}
{geonames_adminCode1}
{geonames_countryCode}
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{geonames_lat}
{geonames_lng}
{geonames_population}
{geonames_fcl}
{geonames_fclName}
{geonames_fcode}
{geonames_fcodeName}
{geonames_distance}
{geonames_geonameId}

51.0651332044118
-1.31870269775391
0
P
city, village,...
PPL
populated place
0.5418
2633858

If Downloader Pro is unable to obtain place name information the tokens above will be replaced with
empty values.
Time Settings
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It is important that Downloader Pro is told what time the camera's clock is set to so that it can use the
timestamps of the images to read the location data from the GPS track log. Normally both the
camera and the computer are both set to local time and you only need to select "Camera is set to
local time". If your camera is set to a different time zone from local time "Camera is set to local time"
should be unchecked and the time zone offset wrt to GMT should be entered e.g. New York in the
summer time (during DST) is four hours behind GMT and so a value of -4 for should be entered for
the offset from GMT.
If your camera clock is out by a few minutes you can compensate for this by entering a value in the
"Camera clock error" field.
If you are unsure that the time settings have been set correctly you can check them by comparing the
"Camera time" display with the current time displayed in the setup menus on your camera.
The "GPS fix window" setting specifies how close the time of a GPS fix in the track log needs to be to
the time the picture was taken for it to be accepted. Setting a large value will increase the chances
that a GPS fix will be found in the track log but it may not be very accurate if the GPS track log has
gaps in its data e.g. if you turn the GPS on, take some pictures in one location for a while then turn
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the GPS off, drive to a new location and forget to turn the GPS on again before taking more pictures
DLPro will record the first location for the second set of pictures if the "GPS fix window" is set to a
large value. If the "GPS fix window" is set to a small value (smaller than the time to drive from the
first location to the second location) it won't find a suitable GPS fix in the track log.
Please note: Setting a large value for the "GPS fix window" only affects the accuracy of the GPS
data stored in the image if there are gaps in the GPS track log. If the GPS track log contains a fix
within a few seconds of when the picture was taken an accurate position will be stored in the shooting
data of the image even if the "GPS fix window" is set to a large value.
Track Log Settings
Downloader Pro also needs to know where to find the GPS track log files and this is specified in the
"Track log settings" section.
Some GPS devices such as the Sony GPS-CS1 simply need to be connected to the PC using a USB
cable and they will appear as a removable drive. With these types of devices Downloader Pro will be
able to find the track log files when the "Search removable drives" option is selected.
GPS receivers such as the Garmin etrex Venture CX can also be used in this way provided the track
logs are stored on a data card and the USB Mass Storage interface option is selected (please see the
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GPS receiver's manual for details).
Many other GPS devices can't be connected directly to a PC as a removable drive and it is
necessary to download the track log files to the PC. With this type of device you need to download
the track log files to your PC and enter the location of the track log folder in the GPS settings dialog
before downloading your photos.
Downloader Pro reads standard NMEA track log files with a .log or .nmea file extension and GPX or
Garmin ForeTrex XML files with a .gpx or .xml file extension.
Downloader Pro can generate a track log file that can be viewed using Google Earth or online using
Google Maps. To do this simply select the type of track log files you require and specify an output
folder where Downloader Pro should write the files. Google Earth track log files have a .kml file
extension and can be viewed by double clicking on the file in Windows Explorer. Google Maps track
log files are web pages and have a .htm file extension. They can be viewed in a web browser by
double clicking on the file in Windows Explorer.
Please note: Google Earth needs to be installed on your computer in order to view Google Earth
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track log files. A free download is available on the Google Earth web site. If you wish to display
Google Maps on your website you will need to obtain a Google Maps API key from http://www.google.
com/apis/maps/ (this is free for consumer use) and enter this in the "Google Maps Key" field in the
GPS Settings dialog.
GPS Accuracy
GPS devices are typically accurate to around 10 or 20 meters and usually write track log data at
regular intervals e.g. every 15 secs. Some GPS devices also store altitude data in the track log file
but this tends to be less accurate the the positional data (latitude and longitude). Downloader Pro
reads the time the picture was taken using the shooting data stored in the image and uses this to
interpolate the position using the location data stored in the track log file.
Please note:
1. Track log data usually isn't written if there is no GPS signal which can happen in built up areas with
tall buildings, in tunnels or inside buildings. When this happens Downloader Pro will interpolate
between the nearest GPS location data from when a picture was taken and this may result in an
inaccurate position.
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2. File size checking is disabled for JPEGs when GPS geo-tagging is enabled. This has the same
effect as setting the "Ignore file size checking" option in Downloader Pro's preferences.
3. It is recommended that the "Use image capture time for file timestamp" option is set in Downloader
Pro's preferences so that the time the picture is taken is read from the shooting data stored in the
image rather than using the file timestamp. This will avoid problems geo-tagging images which
have been modified after they were taken.

Checking Settings Before Downloading
A summary of the GPS track logs available can be displayed by selecting "Check GPS track logs"
from the Edit menu. This will display a list of all the track logs found, the number of GPS fixes they
contains and the date and times of the oldest and newest fixes in the log.
A summary of the GPS data available for a particular image can be displayed by right clicking on the
image and selecting "Check GPS data". This will display the filename, image date and time, date and
time adjusted to UTC, the name of the track log and latitude, longitude and altitude data if available.
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The place name data obtained from www.geonames.org will also be displayed if this option was
selected in the GPS setup dialog. The screenshot below shows an example:
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Launching Downloader Pro when inserting a memory card in a card reader
When Downloader Pro is installed on a computer running Windows 7 or later it is automatically added
to the list of applications Windows displays when a memory card containing images is inserted in a
card reader.
Windows will display a dialog similar to the one below when you insert a memory card containing
pictures into your card reader. Simply double click on the "Download images" camera icon to
download your pictures using Downloader Pro.
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You can tell Windows to automatically launch Downloader Pro without displaying this dialog by
selecting "Always do the selected action".

1.2.8

Command line switches
Downloader Pro recognizes the following switches on the command line:
/d "str"
/f "str"
/j "str"
/p "str"
/s n

specify a new directory format string
specify a new file format string
specify a job code string
specify user profile to load at startup
specify a new image source - 0=auto, 1=camera, 2=cardreader

This is useful if you want to create several desktop shortcuts to run different ways e.g. you may share
a camera and want to download images to different locations. You could create two desktop shortcuts
and add the command line switches below:
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Shortcut 1: /d "D:\Johns photos\{d}"
Shortcut 2: /d "D:\Marys photos\{d}"
When you launch Downloader Pro using shortcut 1 the download directory will be set to "D:\Johns
Photos" + the date the photos were taken.
Please note: When using the /p option to load a user profile any other command line options should
be placed after /p otherwise they will be ignored.
e.g. use:
/p "Johns profile" /d "D:\Johns photos\{d}"
not:
/d "D:\Johns photos\{d}" /p "Johns profile"
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Hiding unnecessary files
You can turn off the listing of files that have already been downloaded by going to the "View" menu
and unchecking "Show downloaded files". This is useful if you are downloading from an external drive
such as the NixVue Vista or Delkin PicturePad when there is a very large number of files. Hiding the
downloaded files makes it easier to see the files that haven't been downloaded yet.
External drives such as the NixVue Vista or Delkin PicturePad work by taking a complete copy of the
conents of your memory card. If you are in the habit of copying a memory card, adding some more
images and copying it again you will end up with some duplicate files on your external drive. You can
instruct Downloader to only display one entry for each duplicate file by unchecking "Show Duplicate
files" in the view menu.
Downloader displays a file as "Duplicate" if it has the same name, size and timestamp as another file
on the source disk and has not been downloaded already. If one of the duplicate files has already
been downloaded all the duplicates will be displayed as "Downloaded".
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1.2.10 Copying files already on your hard disk
You can use Downloader's renaming, IPTC and plug-in features on images already downloaded to
your hard disk. To do this first run Downloader and then either select "Open source directory..." from
the File menu or drag and drop the source folder onto the Downloader window. A prompt will be
displayed asking you whether you wish to use the folder as the image source. If you answer yes
Downloader will scan the dropped folder and all it's sub folders for known image types. You cannot
drag and drop a whole drive in this way, the folder must be a subfolder. Downloader will not allow you
to download or delete any files if the download path is the same as or is a subfolder of the source
folder e.g. you can't download from D:\Photos to D:\Photos\Copy.
WARNING: Please use this function with care and do not delete any source images until you are sure
they have been copied correctly.
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1.2.11 Camera settings dialog
Select "Camera Settings" from the file menu when connected to Canon EOS cameras and older
Canon PowerShot cameras to display the "Camera Settings" dialog:
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This dialog shows information about the camera and allows you to synchronize the camera's internal
clock with your PC's clock and set the Canon camera owner string. Recent Canon EOS camera
models such as Canon EOS 50D and Canon EOS 5D Mark II also support the setting of the artist and
copyright fields. These fields will not be shown if the camera does not support them.
Please note: It may not be possible to sychronize all Canon cameras with the PC's clock to the exact
second but it is possible for it to be no more than one second out of sync.
Select "Automatically synchronize clock when camera is connected" if you would like Downloader Pro
to automatically synchronize the camera's clock to the PC's time each time it connects to the camera.

1.2.12 Download complete sound
This is an experimental feature. To enable this simply place a .wav file named complete.wav in the
Downloader installation directory and it will be played when the download has been completed. There
is an example file called _complete.wav which you can use by renaming it to complete.wav or you
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can provide your own file or recording.

2

Installing, upgrading and registering Downloader Pro

2.1

Installing Downloader Pro
Getting the latest release
The latest copy of Downloader Pro can be downloaded from www.breezesys.com. You can check to
see if you are running the latest version by running Downloader Pro and selecting "Check for
updates" from the help menu.

Installing Downloader Pro
To install Downloader Pro simply run the setup program and follow the on-screen instructions.
Downloader Pro can be uninstalled using the standard Windows "Add/Remove Programs" dialog
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available from "Control Panel".

Upgrading
If you are upgrading your copy of Downloader Pro please uninstall the old version first and then install
the new version. You shouldn't need to re-enter your registration code, but it is a good idea to keep a
copy just in case.

2.2

Registering Downloader Pro
The unregistered version of Downloader Pro is fully functional and can be evaluated for 30 days after
which time it will stop working. During the evaluation period it will display the dialog below every time
it is run. Click "Cancel" if you are not ready to purchase Downloader Pro yet and wish to continue
evaluating it.
If you have already purchased Downloader Pro and have received your registration email you can
enter your details now and then press the "Register" button.
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Please enter your registration details and press the "Register" button. You may find it easier to cut
and paste the code directly from your registration email.
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To purchase a licence for Downloader Pro please visit our website:
http://www.breezesys.com/Downloader or press the "Buy Online" button to go directly to the online
ordering web page. You will be sent an email containing your registration details when your payment
has been received.
You can also display the registration dialog above by clicking on the "Help" menu, selecting "About
Downloader Pro..." and clicking on the "Register..." button.

3

Making the most of Downloader Pro
This section contains useful hints and tips on making the most of Downloader Pro:
·
·
·
·

Running Downloader Pro automatically
Entering the subject or Job Code
Downloading from more than one camera
IPTC/XMP data
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· Sequence numbers and unique numbering
Note: Backup copies of images can be made automatically as they are downloaded using the
backup plug-in
Tip: Many applications and file managers display files and folders in alphabetical order and
storing dates in the form year/month/day will ensure that they are also in chronological order. e.g.
the token {d} will show the date November 22, 2006 as 061122

3.1

Running Downloader Pro automatically
Downloader Pro can be setup to run automatically when a memory card is placed in a card reader. To
do this run Downloader Pro and then select "Register for AutoPlay events" from the "Events" menu.
You can setup the way Windows handles AutoPlay events for each drive by right-clicking on the drive
icon in Windows Explorer and selecting "Properties". Then click on the "AutoPlay" tab, select
"Pictures" from the drop down list and select the required action:
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Entering the subject or Job Code
Often all the pictures being downloaded are of the same subject (e.g. a birthday or a holiday) and it is
useful to include this in the download path. This can be done using the "Job Code". To do this run
Downloader Pro and select "Preferences" from the "File" menu. Then edit the download path to
include the {J} token and select the "Prompt for Job code every time Downloader is run" as shown in
the example below:
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Now every time Downloader Pro is run you will be prompted to enter the job code (or subject) and the
download directory will have this appended to its name. For example you've just been skiing and so
you might enter "Skiing" for the job code so that all the photos are downloaded into the directory:
"D:\Photos\2006\2006-11-21 Skiing"
You can also enter different job codes for photos taken on different days. To do this first display the
image date selector by selecting it from the View menu. Then right click on the required date, select
"Edit job code..." and enter the job code. Downloader Pro can store the job codes for the last 60 days
(see General Preferences) which is useful if several memory cards were used for a vacation or event.
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Downloader Pro's main view with large thumbnails displayed and different job codes for photos taken
on different days

3.3

Downloading from more than one camera
Sometimes you need to download images from several different cameras on the same computer e.g.
if several members of a family each have a digital camera or a professional photographer who has
more than one camera. This section suggests different ways that Downloader Pro can download
images to the right places automatically.

Suggestions for when several people download their images on the same
computer
Lets suppose Bob has a Canon PowerShot G7 and Mary has a Nikon Coolpix 5700 and they both
want to download their images on to the same computer. They want to store the images on the same
hard disk but they also want to be able to easily tell each other's pictures apart. Here are some
suggestions for how to do this:
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1.
2.

3.

Downloader Pro stores settings for each user and so one method would be for Bob and Mary to
have separate user accounts and setup their own personal settings.
Since Bob and Mary use different camera models the download directory could use the camera
model name to separate their images. The token {T1} translates to "G7" for pictures from Bob's
Canon PowerShot G7 and "E5700" for pictures from Mary's Nikon Coolpix 5700. They could
specify the download path as C:\Photos\{T1}\{Y}-{m}-{D} so that pictures are downloaded to
directories like:
C:\Photos\G7\2006-11-04
C:\Photos\E5700\2006-11-04
An alternative to option 2 above is to use the camera mapping setting in preferences to map the
camera model name to something more meaningful e.g. map "Canon PowerShot G7" to "Bob"
and "E5700" to "Mary". Then use {T8} to include the mapped value in the download directory.
They could specify the download path as C:\Photos\{T8}\{Y}-{m}-{D} so that pictures are
downloaded to directories like:
C:\Photos\Bob\2006-11-04
C:\Photos\Mary\2006-11-04
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Please see the camera mapping preference settings for more details.

Suggestions for one photographer with more than one camera
A professional photographer may have several different cameras and use them to cover an event
such as a wedding. When they download the images they want to be able to be able to identify which
camera took which picture and also avoid duplicate filenames. There are a number of ways
Downloader Pro can help:
1.

2.

Use the {T1} token to extract the camera model from the shooting data and use it to prefix the
filename e.g. the cameras might be a Nikon D2X and a Nikon D200. The filename could be
specified as "{T1}_{o}" ({T1} for the camera model and {o} for the original filename on the
memory card) and this would give filenames like D2X_DSC_0001.JPG and
D200_DSC_0001.JPG
Option 1 doesn't help if the cameras are the same model. If the cameras are Canon digital SLRs
or recent Nikon digital SLRs the camera serial number could be used instead. e.g. if the cameras
are both Canon EOS 30D's the filename could be specified as "{c}_{o}" ({c} extracts the camera's

© 2022 Breeze Systems Limited

82

Downloader Pro Help

3.

serial number from the shooting data) and this would give filenames like
0130100302_IMG_0001.JPG and 0230104671_IMG_0001.JPG.
Option 2 is OK, but it does result in long filenames with aren't very meaningful. An alternative is
to use the camera mapping setting in preferences to map the camera model name and serial
number to something more meaningful e.g. map "Canon EOS 30D serial # 0130100302" to
"30D1" and "Canon EOS 30D serial # 0230104671" to "30D2". Then use {T8} to include the
mapped value in the filename e.g. "{T8}_{o}" which would give filenames like
30D1_IMG_0001.JPG and 30D2_IMG_0001.JPG.

This technique can also be used with other cameras provided they allow you to specify a user
comment in the camera which is added to each image. For example the user comments for two
Nikon D200 cameras could be set to "(c) John Smith, camera #1" and "(c) John Smith, camera #2"
and provided the comments are not the same different mappings for {T8} can be setup for each
camera.
Please see the camera mapping preference settings for more details.
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IPTC/XMP data
IPTC data is a method of storing textual information in images. It was developed for press
photographers who need to attach information to images when they are submitting them
electronically but it is useful for all photographers. It provides a standard way of storing information
such as captions, keywords, location and captions. Because the information is stored in the image in
a standard way this information can be accessed by other IPTC aware applications.
Downloader Pro can add IPTC data to the following types of images: JPEG, TIFF, DNG and raw files
from most cameras.
Downloader Pro supports the current Adobe XMP format which was intorduced in Photoshop 7. The
IPTC/XMP data is either stored in the image file (e.g. for JPEGs and TIFFs) or uses an XMP sidecar
file (e.g. for raw files).
Downloader Pro can also optionally store a subset of the IPTC data in the older IPTC IIM format (see
General Preferences)
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Information about the IPTC standard for data stored in images files can be obtained from the IPTC's
web site: http://www.iptc.org

Editing IPTC Data
You can edit the IPTC data by selecting "IPTC/XMP data..." from the edit menu or by typing Ctrl+C.
Alternatively you can get Downloader Pro to display the IPTC/XMP data dialog every time it is run (
see General Preferences). Several sets of IPTC data can be prepared in advance and saved to disk
by entering the data and pressing the "Save to file..." button. The data can then be loaded by
pressing the "Load from file..." button.
The various IPTC data fields can contain fixed text or use the tokens below to automatically insert
data extracted from the image.
Token
{1}

Description
4 digit year "now" (when Downloader was run)
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{2}
{3}
{a}
{A}
{b}
{B}
{c}
{C}
{d}
{D}
{F}
{H}
{i}
{I}
{j}
{J}
{l}

2 digit month "now" (when Downloader was run)
2digit day "now" (when Downloader was run)
Abbreviated weekday name e.g. Fri
Full weekday name e.g. Friday
Abbreviated month name e.g. Jan
Full month name e.g. January
Camera serial number (Canon digital SLRs and recent Nikon digital SLRs only)
Canon EOS 1D/1DS style serial number
Date in the form YYMMDD
Day of the month (01 to 31)
Name of downloaded file without file extension
Hour in 24-hour format (00-23)
ISO
Hour in 12-hour format (01-12)
Day number (001 to 366)
Job code
Long date/time representation for locale e.g. Saturday, April 13, 2002 09:27:32
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{L}
{m}
{M}
{o}
{O}
{p}
{plc}
{q}
{Q}
{r}
{r1}
{r2}

Long date representation for locale e.g. e.g. Saturday, April 13, 2002
2 digit month number (01 to 12)
minutes
Source filename without extension e.g. IMG_0001
Owner's name (Canon cameras only)
AM/PM indicator in upper case
am/pm indicator in lower case
Source folder number e.g. 123
Source folder name e.g. 123CANON
Source image number e.g. 4567
Last digit of source image number e.g. 7
Last two digits of source image number e.g. 67

Note: All dates and times are taken from the date and time the picture was taken unless otherwise
stated
The IPTC Data dialog is divided up into five different sections: Caption, Keywords, Categories,
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Contact, Origin and Image. If legacy IPTC IIM is selected in preferences a tab labeled "Legacy IPTC
IIM" will also be displayed. Click on the tabs along the top of the dialog to select the required section.
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All the data fields under the Caption tab are free text entries for Copyright Status and Urgency are
free text entries. The urgency is a number from 0, meaning "None", through 1 (meaning "High") to 8
(meaning "Low"). The default value is "0: None".
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Click on the Keywords tab to display the keywords. The keywords are displayed in the order they
were entered (as opposed to alphabetical order) and each keyword must be unique. To add a new
keyword enter the keyword in the text edit area at the top and either press the Enter key or the Add
button. Several keywords can be added in one go by entering a list separated by commas or
semi-colons.
To delete a keyword first select it from the list then press the Delete button.
Press the "Catalog..." button to display a list of pre-defined keywords in the dialog below:
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The keyword catalog is read from a simple tab delimited file called keywords.txt in the Downloader
Pro installation folder (if keywords.txt can't be found Downloader Pro will try to load
sample_keywords.txt instead). The sample_keywords.txt file included with Downloader Pro is a small
extract from the controlled vocabulary created by David Riecks. Please visit
http://www.controlledvocabulary.com for details of the considerable benefits of using a controlled
vocabulary for keywords and to purchase the full keyword controlled vocabulary file.
Keywords can be selected by browsing the keyword tree or by entering a search string and pressing
the Find button. Then press the OK button or double click on the item in the tree to copy the selected
keywords to the IPTC/XMP keyword dialog.
Synonyms are shown in braces/curly brackets after the keyword and are included when searching.
Synonyms are only copied to the "Selected Keywords" with the main keyword when "Include
synonyms with selected keywords" is selected.
In the screenshot above the user has searched for "swine" which is a synonym for "pigs" along with
the synonyms "hogs", "pig", "piggies" and "piggy".
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Items enclosed in square brackets are headings to help organize the keywords and are not copied to
the "Selected Keywords" when you click on them.
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Click on the Categories tab to display categories. The main category is a free text entry. The
supplemental categories are displayed in the order they were entered (as opposed to alphabetical
order) and each one must be unique. To add a new supplemental category enter it in the text edit
area at the top and either press the Enter key or the Add button. To delete a supplemental category
first select it from the list then press the Delete button.
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All the data fields under the Contact tab are free text entries.
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All the data fields under the Origin tab are free text entries except for the "Date Created" and "Time
Created" fields. The date must contain a date in the form YYYYMMDD where YYYY is the year
including century (e.g. 2007), MM is the month (e.g. 03 for March) and DD is the day (e.g. 26). An
optional : or / character may also be used to separate the year, month and date. Press the ">" button
after "Date Created" to display a menu to set the date/time to the EXIF shooting date, the file creation
date, the current time, yesterday, two days ago or select any date using the date/time dialog (shown
below).
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Click on the ">" button after "Release Date" to set the release time to now, tomorrow, two days time,
one weeks time, two weeks time or select any date using the date/time dialog.
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The rights usage field is a free text entry field and is normally used to enter further information about
the image and how it may be used. The intellectual genre field specifies the genre of the image using
the list of genres defined by the IPTC. The IPTC scene and subject code fields should contain a list of
numeric IPTC scene and subject code values classifying the image. These values use a controlled
vocabulary defined by the IPTC to standardize their usage. Click on the "Catalog..." button to display
the dialog below to select the codes:
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The IPTC subject code editor is shown above. On the left is a list of subject codes which can be
expanded by clicking on the + and - buttons. When you click on an item in the list its formal name or
code is displayed on the right together with a description of the item. The current values for the image
are displayed on the right and this list can be added to by pressing the "Add" button or by selecting an
item from the list on the left and pressing return. Items can be deleted by selecting the item from the
list on the right and pressing the "Remove" button or the delete key.
You can search for whole or partial words in the name or explanation by entering a search string in
the bottom left and clicking on the "Find" button.
The scene editor is very similar in appearance but only has a single level list of names on the left
hand side.
The values displayed in this dialog (and in the intellectual genre list in the IPTC editor Image section
above) are read from XML news code topicset files supplied by the IPTC. These are stored in the
topicset folder where Downloader Pro is installed (usually C:\Program Files\BreezeSys\Downloader
Pro \topicset). The files are named as follows: topicset.iptc-genre.xml, topicset.iptc-scene.xml and
topicset.iptc-subjectcode.xml. At the time of writing the IPTC have translated topicset.iptc-genre.xml
into Spanish (topicset.iptc-genre_es.xml) and topicset.iptc-subjectcode.xml into German
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(topicset.iptc-subjectcode_de.xml), Spanish (topicset.iptc-subjectcode_es.xml) and French
(topicset.iptc-subjectcode_fr.xml). The translated files can be used in Downloader Pro's IPTC subject
code editor by downloading the relevant file from http://newscodes.org and renaming it e.g. to use the
French translation of the subject codes download topicset.iptc-subjectcode_fr.xml from
http://newscodes.org, rename it to topicset.iptc-subjectcode.xml and copy it into Downloader Pro's
topicset folder.
The copyright of the XML topicset files belongs to the IPTC and are included with Downloader Pro
with the IPTC's permission.
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The "Legacy IPTC IIM" tab contains IPTC IIM fields which do not have direct IPTC XMP equivalents
and is provided for backwards compatibility with older apps.

3.5

Sequence numbers and unique numbering
Downloader Pro has a number of tokens to help number images in different ways. If you are using a
Nikon digital SLR or a Canon EOS 1D series camera and simply want to ensure each image has a
unique filename consider using the shutter activation count token {r8}. For other cameras the
"sequence number" or "time since the epoch" tokens can be used. The "uniqueness" tokens are
useful if your naming scheme doesn't always produce unique filenames e.g. naming the files using
the date and time and then shooting continuous bursts at more than one frame per second.
The sequence number tokens are useful if you want to number images as they are downloaded e.g.
numbering shots from a particular event or the number of shots taken this year.
Shutter Activation Count
Nikon digital SLRs and Canon EOS 1D series SLRs store the shutter activation count (i.e. the number
of pictures taken since the camera was new) in the shooting data. This information can be accessed
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using the {r8} token and will guarantee unique filenames for a given camera body.
e.g. Set download filename to:
{r8}
shutter activation count
{d}_{r8}
date image taken + shutter activation count
{t}_{r8}
time image taken + shutter activation count
{r85} and {r86} can also be used for the shutter activation count but pad the number with leading
zeroes to give a five or six digit number respectively. e.g. a shutter activation count of 123 would give
the following values
{r8}
123
{r85}
00123
{r86}
000123
Sequence Number
Downloader Pro can keep a count of downloaded images which can be used to number images as
they are downloaded. The count is stored when Downloader Pro exits and continues from where it left
off. The starting number can also be set in preferences
The sequence number is useful for numbering shots from a given event, particularly if the shots span
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more than one memory card. It can also be used to number images from a given point e.g. shots
taken this year.
There are six tokens for sequence numbers:
{seq#} - sequence number with no leading zeroes
{seq#2} - 2-digit sequence number padded with leading zeroes e.g. 01, 02 etc.
{seq#3} - 3-digit sequence number padded with leading zeroes e.g. 001, 002 etc.
{seq#4} - 4-digit sequence number padded with leading zeroes e.g. 0001, 0002 etc.
{seq#5} - 5-digit sequence number padded with leading zeroes e.g. 00001, 00002 etc.
{seq#6} - 6-digit sequence number padded with leading zeroes e.g. 000001, 000002 etc.
Uniqueness
The uniqueness tokens are useful for ensuring the download filenames for a given download are
unique. For example if images are named using the time they were taken to the nearest second, e.g.
using the {t} token, the uniqueness tokens can be used to prevent duplicate names when shooting
continuous bursts at more than one frame per second.
There are two groups of uniqueness tokens: those using lower case 'l' e.g. {l}, {l2}, {l3}, {l4} and those
using upper case 'L' e.g. {L}, {L2}, {L3}, {L4}
The lower case 'l' tokens evaluate to an empty string if the filename is unique and start numbering
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from 1 for subsequent non-unique filenames. The upper case tokens on the other hand always
evaluate to at least 1. {l2}, {l3} and {l4} work the same way as {l} but pad the number with leading
zeroes to make 2-digit, 3-digit or 4-digit numbers respectively. Similarly {L2}, {L3} and {L4} work the
same way as {L} but pad the number with leading zeroes to make 2-digit, 3-digit or 4-digit numbers
respectively.
e.g. Suppose three JPEG photos were all taken at 18:30:54 at 5 frames per second:
Setting the download filename to {t} would give three duplicate filenames of 183054.jpg
Setting the download filename to {t}{l} would give the following filenames: 183054.jpg, 1830541.jpg,
1830542.jpg
Setting the download filename to {t}{l2} would give the following filenames: 183054.jpg, 18305401.
jpg, 18305402.jpg
Setting the download filename to {t}_{l2} would give the following filenames: 183054.jpg, 183054_01.
jpg, 183054_02.jpg
Setting the download filename to {t}{L} would give the following filenames: 1830541.jpg, 1830542.jpg,
1830543.jpg
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Setting the download filename to {t}{L2} would give the following filenames: 18305401.jpg, 18305402.
jpg, 18305403.jpg
Setting the download filename to {t}_{L2} would give the following filenames: 183054_01.jpg,
183054_02.jpg, 183054_03.jpg
Tip: Downloader Pro automatically removes trailing spaces and underscore characters from
filenames. This is useful when used with the {l} token as the underscore can be used for visual
separation of the uniqueness number and is suppressed when not needed. e.g. if the download
filename is set to {t}_{l} and {l} evaluates to an empty string the _ will be removed automatically as in
the example above.
Notes:
1. The uniqueness tokens only work within the context of the images in the current download.
Downloader Pro doesn't examine images already in the destination folder before generating unique
filenames
2. Some cameras (e.g. Nikon digital SLRs and recent Canon DSLRs) store the time the image was
shot to the nearest 1/100th second in the shooting data. With these cameras the subsecond timing
token, {s}, can be used instead of the uniqueness tokens when naming files using only the time the
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image was shot e.g. by setting the download filename to {t}{s}
Time Since the Epoch
The "time since the epoch" is used by many computer systems to count the number of seconds since
midnight UTC on Jan 1, 1970. Downloader Pro provides two tokens to represent the time since the
epoch: {epoch} and {epoch36}. {epoch} displays the number as a 10-digit number whereas {epoch36}
provides a shorter string by representing the number of seconds in base 36 using the characters 0 to
9 and A to Z.
e.g. 14:30:44 on November 21, 2006 gives:
{epoch}
1164119444
{epoch}
J934B8
The time since the epoch is an alternative to generate unique filenames for images from a given
camera body.
e.g. Set the download filename to:
{epoch}
number of seconds since the epoch (10-digit number)
{epoch36}
number of seconds since the epoch in base 36 (6-character string)
{epoch36}_{r} seconds since the epoch followed by the image number assigned by the camera
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seconds since the epoch followed by uniqueness number if shooting continuous

Note: The "time since the epoch" can only represent times from midnight UTC on Jan 1, 1970 to
03:14:07 UTC on Jan 19, 2038.

3.6

User profiles
Different sets of Downloader Pro settings can be saved as user profiles to cater for different
download requirements e.g. a professional photographer may have a number of assignments with
different download requirements such as filenaming or IPTC data and these could be saved in
advance as different user profiles and then quickly recalled as required. Downloader Pro can also be
setup to automatically prompt for which user profile to use at startup.
The currently selected user profile is displayed in the window title bar in square brackets after
"Downloader Pro" unless the default profile is selected.
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Saving user profiles
To save the current settings as a new user profile click on the "File" menu and select "Save..." from
the "User Profiles" section and the dialog below will be displayed:
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Enter the name of the profile and optional description and press the OK button. All the current
settings including the download path, filenames, camera mappings, IPTC settings and plug-in settings
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will be saved and the new profile name will be displayed in Downloader Pro's window title bar.
Please note:
1. User profile names must not contain \ characters
2. Any changes to settings since Downloader Pro was run will be saved under the new user profile
and not the profile that was selected before saving the new profile

Loading user profiles
To load a previously saved user profile click on the "File" menu and select "Load..." from the "User
Profiles" section and the dialog below will be displayed:
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Click on the profile names from the list to display their descriptions and then either double-click on
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the item in the list or click on the OK button to load the user profile. The current settings are saved
under the current user profile before loading the settings for the new profile.
Notes:
1. The special profile name {default} is reserved for the default user profile. When this profile is
selected no profile name is displayed in Downloader Pro's window title bar.
2. The load user profile dialog can be displayed automatically at startup by selecting the "Prompt for
user profile at startup" in Downloader Pro's preferences.

Deleting user profiles
To load a user profile click on the "File" menu and select "Delete..." from the "User Profiles" section
and the dialog below will be displayed:
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Click on the profile names from the list to display their descriptions and then either double-click on
the item in the list or click on the OK button to delete the user profile. A yes/no dialog will be
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displayed asking you to confirm that you want to delete the user profile.
Please note:
1. The currently user profile cannot be deleted. To delete the current profile please load a different
profile first.
2. The default profile cannot be deleted

4

Preference settings
Click on the File menu and select Preferences to display the Preferences dialog to configure
Downloader Pro.
Select "Export Downloader Pro settings..." from the File menu to save your settings to a Windows
registry file. This file can be used to restore your settings at a later date or for copying your settings to
another PC. To restore your settings first make sure no copies of Downloader Pro are running on your
computer and then simply double click on the registry file in Windows Explorer. Windows will display
a warning message saying something like "Are you sure you want to add the information in
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C:\DLPro.reg to the registry?". Click on the "Yes" button to load the settings.

© 2022 Breeze Systems Limited

123

124

4.1

Downloader Pro Help

Download path
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The download directory is the base directory for where images are downloaded to the computer.
Press on the "..." button to browse for a new directory. The actual directory where the files are
downloaded can be modified using the various tokens listed on the dialog. The default setting is
"C:\Photos\{d}" which will download the images to separate folders according to the date when the
photo was taken.
A list of the last 12 settings used for the download directory and filename can be recalled by clicking
on the dropdown arrow to the right of the text entry area.
Here are some alternatives you might find useful:
Download directory Description
Example
C:\Photos\{T}\{d}
use the camera model and date the photo C:\Photos\10D\20030416
was taken
C:\Photos\{1}-{2}-{3} use today's date i.e. the download date not C:\Photos\10D\20030417
the date the picture was taken
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{u}\{d}

the date the picture was taken + "My
Pictures" folder Note: {u} gives "My
Documents" not "My Pictures" with some
versions of Windows
C:\Photos\{Y}\{Y}-{m}-{ use the year, month and day the photo was
D}
taken (this is the one I use)
C:\Photos\{d} {J}
use the job code and the date the image
was taken
C:\Photos\{O}\{d}
use the camera owner string (Canon
cameras only) and date
C:\Photos\{c}\{d}
use the camera serial number (Canon
digital SLRs and recent Nikon digital SLRs
only) and date

C:\Documents and
Settings\chris.TYPHOON\My
Documents\My Pictures
C:\Photos\2003\2003-04-16
C:\Photos\20030416 Katy's
birthday
C:\Photos\Chris
Breeze\20030416
C:\Photos\0230104671\2003041
6

The filename can also be specified using these tokens. The default setting is {o} which keeps the
original filename. Here are some alternatives you might find useful:
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Filename
{d}_{o}

Description
Example
prefix the original filename with the date the photo 030214_IMG_0123.JPG
was taken
{q}_{o}
prefix the original filename with the folder number 678_IMG_0123.JPG
on the memory card
{q}-{r}_{f}
use Canon ZoomBrowser style naming where the 678-0123_IMG.JPG
image name is prefixed with the folder number
{J}{d}_{o}
prefix the original filename with the job code and
Katy's birthday
the date the photo was taken
20030416_IMG_0123.JPG
{d}_{t}_{r1}
date and time the image was taken plus the last
031029_223015_7.JPG
digit of the image number to avoid duplicate file
names when shooting at more than 1 frame per sec
{d}_{H}{M}_{r2} date and time (hours and minutes) the image was 031029_2230_18.JPG
taken plus the last two digits of the image number
to avoid duplicate file names when shooting several
pictures each minute
{i}_{o}
prefix the filename with the ISO setting. Useful
400_IMG_0123.JPG
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{d}_{seq#6}

when post processing images based on the ISO
setting e.g. NeatImage
date plus six-digit sequence number

061121-001234

The example image name display at the bottom of the dialog shows how the download directory,
filename and job code settings are combined.
The job code provides a useful way for organizing your photos as you download them. The job code
can be included in the download directory or filename using {J}. When "Prompt for job code every
time Downloader Pro is run" is selected you get the opportunity to edit the job code before
downloading your images.
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For example you might set the download directory to be "D:\{Y}\{Y}-{m}-{D} {J}" then enter a
description of the event in the job code. Then when you take photos of your daughter's birthday party
you could enter "Katy's birthday" for the job code and the files will automatically be stored in a
directory with the date and description e.g. "D:\2006\2006-02-13 Katy's birthday\IMG_0001.JPG". The
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next set of photos you take might be on holiday and so you could enter "Skiing 2006" when you
download them.
Professional photographers can use the job code to enter a unique code for each job and add it to
download directory and the name of each photo to make identification easier.
The shooting data can be used with the following image formats: JPEGs and TIFFs from all digital
cameras, Canon raw files (CRW and TIF), Nikon NEF raw files, Fuji RAF raw files, Olympus ORF
raw files, Pentax PEF raw files, Minolta MRW raw files, Sony raw files, Canon AVI movie files, Kodak
DCR raw files, DNG raw files.
Press the "Show tokens..." button to display a list of the available tokens and their values for the
example file:
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If you are using a card reader the example file data is taken from the first image on the memory card.
The download sequence number tokens (e.g. {seq#}) keep a count of the number of images that have
been downloaded using Downloader Pro. The sequence number starting value is saved when
Downloader Pro exits and reloaded next time it is run. It can also be set to any required value in
preferences.
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General
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The "Image Source" section lets you specify whether Downloader Pro should download from a
camera or from a card reader.
To use a card reader you must also specify the drive letter associated with the card reader. If you are
unsure of the drive letter to use, simply insert a memory card in your card reader and press the
"Locate card reader" button and Downloader Pro will fill this in automatically.
You can specify one drive letter, several drive letters or a range of drive letters. Use a hyphen to
specify a range of drive letters e.g. G-I to specify drives G, H and I. Downloader Pro will scan the
drive letters in the order defined until it finds a drive containing images.
Select the "Disable PTP downloads" when downloading using a card reader on Windows 10. This is
because Windows 10 treats memory card readers as PTP devices which can cause problems
because PTP does not support the downloading of raw images. "Disable PTP downloads" should not
be selected if you wish to download images directly from phones or cameras from manufacturers
other than Canon.
Downloader Pro can download directly from Canon cameras via the USB cable. If more than one

© 2022 Breeze Systems Limited

Preference settings

135

camera is connected to your computer when Downloader Pro starts up it will display a dialog to allow
you to choose which camera to connect to. You can run more than one copy of Downloader Pro at
the same time and simultaneously download from several cameras.
If you select the auto-detect option Downloader Pro will attempt to connect to a camera first, and it
this fails it will then try to access a card reader using the drive letters defined in the dialog.
Select "Prompt for user profile at startup" to have Downloader Pro display a dialog allowing you to
select from the available user profiles to load at startup. Please see the section on user profiles for
more information.
The "Save files as read-only" checkbox controls whether the read-only flag is set when files are
downloaded. Setting files to read-only is a useful precaution against accidentally deleting files or
overwriting them when editing.
When "Preserve read-only status" is selected read-only (or protected) images are set to read-only
when they are downloaded. This option is useful if you wish to mark certain images in the camera by
protecting them and then later select them BreezeBrowse Pro using the "select read-only images"
option. Please note that this option is disabled if "Save files as read-only" is selected.
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The "Ignore file size check" checkbox is useful if you download some files, rotate them in an editor
and then download some more files. Lossless rotation of JPEG images in applications such as
BreezeBrowse Pro changes the file size slightly and this causes Downloader Pro to display these
images as "Size different". The "auto-rotate" JPEG option will also cause the file size to change.
The "Auto-rotate JPEG" option will automatically rotate JPEGs which rotated in the camera. An
increasing number of cameras have a built-in sensor which detects whether the image was taken in
landscape or portrait format and writes this information in the EXIF shooting data. Downloader Pro
reads this information and can automatically rotate the JPEG so that it is displayed with the correct
orientation in other apps. The "Ignore file size check" option is automatically selected when
"Auto-rotate JPEG" is selected to prevent images being displayed as "Size Different" after
downloading and rotating.
Note: Please don't use the "Auto-rotate JPEG" option if you are shooting raw+JPEG files and wish to
view the images linked as raw+JPEG pairs in BreezeBrowser Pro as this may cause the images to be
displayed incorrectly rotated.
Some digital cameras use .jpe as the file extension for JPEG images. This can be very inconvenient
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as most applications expect JPEGs to have a .jpg file extension. Use the "Rename files with .jpe
extension" option to automatically rename these files to give them a .jpg file extension when they are
downloaded.
The filenames of images on memory cards are always in upper case. Select "Convert filenames to
lower case" if you prefer the downloaded files to use lower case letters. Select "Lower case file
extensions" if you want just the file extension to be converted to lower case e.g. IMG_0123.JPG
would be downloaded as IMG_0123.jpg.
By default Downloader Pro uses the file timestamp for date and time information but this can be
different from the image capture time when taking long continuous sequences of images because
some cameras set the file's timestamp to the time the image was written to the memory card not the
time the image was taken. Select the "Use image capture time for file timestamp" to avoid this
problem when downloading from a card reader or directly from a camera. When this option is
selected Downloader Pro will read the image capture time from the image's shooting data and use it
for the timestamp. This option can be slower than using the file's timestamp.
Date based job codes for the last 60 days can be saved when Downloader Pro exits so that they are
available next time Downloader Pro is run by selecting "Save date based job codes for next time
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Downloader Pro is run".
Select "Generate text file containing EXIF shooting data" to create a text file file containing a
summary of the image's shooting data. The text file is given the same name as the source image but
with a .txt extension e.g. IMG_0001.JPG will give IMG_0001.txt.
Some versions of Windows (Windows 2000 and Windows XP) can cause problems when using a
card reader if the card isn't "ejected" before it is removed. This is because Windows doesn't write
data back to the card reader immediately so it is possible to remove one memory card and insert
another before the data from the first card has been saved. This can result in the directory from the
first card overwriting that of the second card making the images on the second card inaccessible. To
avoid this it is always a good idea to "eject" the card first before removing it. This doesn't actually
physically eject the memory card from the card reader but it does prepare it for removal. You can get
Downloader Pro to automatically "eject" the memory card from the card reader when it disconnects
from it by checking this checkbox.
By default Downloader Pro only looks for images stored according to the DCF standard where the
root directory is \DCIM and the images are stored in subdirectories with 8 character names starting
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with 3 digits (e.g. 123CANON). Some cameras don't follow this standard but you can still use
Downloader Pro with them by setting "Scan whole disk for known image types".
Downloader Pro supports the current Adobe XMP format which was intorduced in Photoshop 7. The
IPTC/XMP data is either stored in the image file (e.g. for JPEGs and TIFFs) or uses an XMP sidecar
file (e.g. for raw files). Downloader Pro can also optionally store a subset of the IPTC data in the older
"legacy" IPTC IIM format.
Important note adding legacy IPTC IIM data to Nikon NEF raw files: Some raw converters are
unable to convert raw files after IPTC IIM data has been added by Downloader Pro. Please check
very carefully that your raw converter is able to convert Nikon NEF raw files after adding IPTC data
before deleting the images from the memory card. IPTC data will not be added to Nikon NEF files
unless "Enable writing of legacy IPTC IIM data to Nikon NEF raw files" is set.

4.3

Automation
You can setup Downloader Pro to automatically download files, delete the downloaded files, launch
the custom application and exit when it is started up. To enable automation click on the File menu,
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select Preferences and click on the Automation tab. Then select the actions you wish to be
automated.
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When automation is enabled a dialog is displayed when Downloader Pro starts up asking you whether
you want to continue. If you press the "Yes" button Downloader Pro will start the automatic sequence.
The sequence will stop if you cancel it or an error occurs. You can suppress the prompt by
unchecking the "Prompt before starting auto sequence" checkbox.
Note: Automatically deleting files from you CF card might sound risky, but remember that
Downloader Pro will never delete files from the card unless they have been downloaded successfully.
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Custom button
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Select "Enable custom button" to define a custom button to launch an application of your choice. If
you would like to run BreezeBrowser or BreezeBrowser Pro when the custom button is pressed simply
select "Link button to BreezeBrowser Pro or BreezeBrowser". Note: this requires any version of
Breezebrowser Pro or BreezeBrowser v2.5 or later to be installed on your system. BreezeBrowser Pro
can be downloaded from www.breezesys.com.
To launch a different application enter the button's caption and the command line to be executed
when the button is pressed.
e.g. The following command line could be used to open the folder in Windows Explorer:
C:\Windows\explorer.exe %d

4.5

Camera name mapping
The camera name mapping preferences allow you to define a value to be used for the {T8} and {T9}
tokens for different camera models. This is useful when using different cameras or when the camera
name stored in the shooting data is awkward (e.g. Canon EOS DIGITAL REBEL) or when several
photographers are shooting with the same type of camera.
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The list area at the top of the window shows the currently defined mappings e.g. the value of {T8} for
images from the Fuji FinePix S3 Pro is mapped to "Fuji S3" and {T9} is mapped to "Fuji". {T8} and
{T9} can then be used to specify the filename or download directory of downloaded images. For
example the mappings shown in the screenshot could be used to sort images from different
manufacturers' cameras into different folders using {T9} (Canon, Fuji, Olympus, Nikon etc.) and the
values for {T8} could be used to prefix the filenames with the camera model.
To add a camera to the list either drag and drop an image on the dialog window using Windows
Explorer or click on the "Add camera..." button and select an image. To remove a camera from the
list first select it by clicking on its entry in the list then click on the "Delete" button. You can also add
the current camera when using a card reader by pressing the "Add" button.
Select the "Identify camera using serial number, owner string or user comment" checkbox if you have
more than one camera of the same type and wish to identify them separately. When this option is
selected the camera serial number (Canon EOS digital SLRs and recent Nikon digital SLRs), owner
string (other Canon cameras) or user comment (settable in some other cameras e.g. Nikon D200) is
appended to the camera model name to identify individual cameras. For example, in the screenshot
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above mappings have been defined for two Canon EOS 1D Mark II cameras: one with serial number
0000200192 which sets {T8} to "1D2_1" and the other with serial number 0000225600 which sets {T8}
to "1D2_2".
To edit the values of the {T8} and {T9} tokens for a given camera model either double-click on the
item in the list or select it and then press the "Edit..." button. The values can be set to any valid
Windows filename character. It may also contain another token e.g. {d} for the date.
Select the "Prompt for camera mappings when a new camera is detected" checkbox to have
Downloader Pro prompt for the values to use for {T8} and {T9} when a new camera is detected.
When this happens the dialog below is displayed:
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Enter values for {T8} and {T9} and press "OK" to mappings for the new camera. Press "Skip this
Camera" if you do not wished to enter values for this camera (you won't be prompted again to enter
values for this camera until next time Downloader Pro is run) or press "Skip All" if you do not want to
be prompted for any more cameras this session.
Please note: You will only be prompted to enter values for new cameras if either the {T8} or the {T9}
token is used to specify the download filename or directory.
Please see the section on Making the most of Downloader Pro for more details of how to use camera
name mappings.
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Plug-ins are extensions to Downloader Pro which are run on images after they are downloaded.
Please see the Plug-ins page for details of the plug-ins that come with Downloader Pro. Click on a
plug-in in the list to select it and display a short description of its function at the bottom of the dialog.
Plug-ins can be enabled or disabled by checking and unchecking the "Enable plug-in" checkbox.
Press the "Setup..." button to configure the plug-in.
You can change the order in which plug-ins are run by selecting a plug-in from the list and pressing
the Up or Down buttons.
Note: The order in which the JPEG auto profile and JPEG resolution plug-ins are run doesn't matter.

5

Plug-ins
Plug-ins are a way of extending Downloader Pro's functionality. They can be run on each image after
it has been downloaded. Plug-ins can be enabled and disabled and configured from the Plug-ins
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Prefences dialog. Downloader Pro comes with three plug-ins: one to automatically tag JPEGs with
color profiles, one to adjust the resolution of JPEGs and one to automatically create empty directories
to support your workflow.
A simple SDK is available on the Downloader Pro support page of the Breeze Systems website. This
can be used to write your own plug-ins in C++.

5.1

JPEG auto profile
The JPEG auto profile plug-in allows you to automatically embed (or tag) a JPEG image with a color
profile as it is downloaded. This saves time and possible confusion over color spaces when images
are edited in color space aware applications such as Photoshop. You can specify different color
profiles to use for different camera models using the setup screen below:
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To add a new camera model to the list you can either drag a JPEG from that camera and drop it on
the setup dialog or press the "Add camera..." button and use the standard Windows file open dialog to
locate an example JPEG. Then click on the "Profile..." button to locate the color profile to be
embedded in JPEGs from the selected camera model.
Select "Identify camera using user comment or serial number" if you have more than one camera of
the same model and wish to assign different profiles to each. Normally this option will be left
unchecked, but it is useful if you shoot using different color spaces with different cameras or have
created individual color profiles for each camera.

5.2

JPEG resolution
JPEGs from digital cameras usually contain EXIF data which specifies the resolution of the image in
DPI. Applications such as Photoshop and Photoshop Elements use the DPI value to calculate the
print size of images (size in inches = size in pixels / DPI). The problem is that cameras often set the
DPI to an unsuitable value. The JPEG resolution plug-in can be used to automatically change the DPI
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value to a user-defined DPI or dots/cm value. The plug-in will modify the EXIF XResolution,
YResolution and ResolutionUnits values and add a JFIF header containing the new resoltion value.

To setup the plug-in simply select the resolution units from the drop down list (DPI or dots/cm) and
enter the required resolution value.
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Directory maker
This plug-in is designed to help create a directory structure to support your workflow. As images are
downloaded the plug-in creates empty directories relative to the download directory. For example
suppose images are downloaded to the directory D:\Photos and you wish to create a directory for
images which require more work called "working", a directory for finished images called "edited" and
a directory for images prepared for web pages called "web". You can do this using the directory
maker plug-in as shown below:
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Alternatively you may prefer to download your images to a directory named "originals" and have the
additional directories at the same level. This can be done be prefixing the directory names with "..\"
(".." is a way of specifying the parent directory).
e.g. Files are downloaded to the a new download directory for each day by specifying
"D:\Photos\{Y}-{m}-{D}\originals" in the Download Path preferences.
In the Directory maker plug-in setup page the following directories might be specified:
1.
2.
3.

..\edited
..\web
..\working

This would result in the following directory structure after downloading images on April 21, 2004:
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The images would be downloaded to D:\Photos\2004-04-21\originals and the empty directories
edited, web and working would be created ready for processing the images.

5.4

Backup
This plug-in automatically creates up to two backup copies of your images as they are downloaded.
You can use exactly the same tokens to specify the download directory and filename as for the main
download (see Preferences). Select "make backup files read-only" if you wish to make the backup
files read-only and less likely to be accidentally overwritten or deleted.
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Both the primary and secondary backups have the option to backup all files, JPEGs only or
non-JPEGs only. This is useful if you are shooting raw+JPEGs and wish to copy JPEG proofs to one
location for your client and the raw files to another location for backup purposes.
Please ensure you have plenty of spare space on the drive you are using for backups when using this
plug-in.
Please note: The drive used for backups must be a normal read/write drive such as a hard disk. The
plug-in can't be used to backup files to a CD or DVD writer.

5.5

DNG Convert
This plug-in automatically creates a DNG version of raw image files as they are downloaded. It uses
Adobe's free DNG converter (which must be downloaded separately) to convert the raw files to DNG
format. Please see Adobe's website for more information about the DNG file format:
http://www.adobe.com/dng
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In order to use this plug-in you must first download and install Adobe's DNG Converter on your PC.
This is free and can be downloaded from http://www.adobe.com/dng. This is regularly updated by
Adobe to support new cameras as they become available.
Next enter the location of the DNG converter by pressing the "..." browse button and select the
required options.
The compatibility dropdown list can be used to select older versions of the DNG standard for
compatibility with older versions of Adobe Camera Raw, Photoshop and Lightroom. This is useful if
you have an older version of Photoshop or Lightroom which does not support raw conversion for a
new camera e.g. if you have Photoshop CS and wish to convert raw files from a Canon EOS 5D Mark
II or a Nikon D700 the compatibility should be set to "Camera Raw 2.4 and later (Photoshop
CS/Lightroom 1.0)". This will tell the DNG converter to generate DNG files which are compatible with
Photoshop CS and Lightroom 1.0.
The compatibility setting only needs to be changed from its default value of "Latest DNG standard
supported by DNG converter" if you need to generate DNG files which are compatibile with older
versions of Photoshop, Lightroom or other software.
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By default the DNG file is stored in the same directory as the raw file. You can specify a different
directory for the DNG files by entering the path in the "Directory for DNG file:" text box. This can be
specified as a relative path as in the screenshot above or an absolute path such as "C:\DNG files".
Examples of different DNG directory paths:
Directory
DNG

Description
Creates DNG files in a sub directory called DNG relative to the raw files. e.g.
raw file path: C:\Photos\2005-11-12\IMG_1234.CR2
DNG file path: C:\Photos\2005-11-12\DNG\IMG_1234.dng
C:\DNG files
Creates DNG files in the directory "C:\DNG files"
D:\DNG\{Y}\{Y}-{m}- Creates DNG files in a directory using the date the picture was taken e.g. the
{D}
DNG file from a raw file taken on Nov 2, 2005 would be stored in D:
\Photos\2005\2005-11-05
Please note that it takes several seconds for the DNG converter to convert each file and so it will take
longer to download files when this plug-in is used.
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Adobe, Photoshop and Lightroom are registered trademarks of Adobe Systems Incorporated.

6

Trouble Shooting

6.1

Error Messages
Sometimes Downloader Pro is unable to download all your files and may display a message like "25
files to download of which 3 are problem files" in the status line at the bottom of the main window.
You can find out more information about the status of each file by looking at the Status column in the
main window. Normally this shows either "New file" indicating that the file has not been downloaded
yet or "Downloaded" indicating that it has been downloaded successfully.
You can display more information about the status of each file by right clicking on it and selecting
"Download Status" from the popup menu.
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Some possible reasons for different status types and what action you can take to avoid problems are
listed below:
"Size different"
This usually indicates that a file of the same name has already been downloaded to your PC and
Downloader Pro can't download the file on the memory card without overwriting the one on your PC.
The usual reason for this is your camera is set to reset the file numbering each time an empty
memory card is used. If your camera is set this way the first set of pictures you take will be numbered
starting from IMG_0001.JPG. If you download these images, erase your memory card and take some
more pictures these will also be numbered starting from IMG_0001.JPG. When you try to download
the second set of images they will have the same filenames as the first set of images and
Downloader Pro will not be able to download them.
The easiest way to avoid this problem is to turn off the file number reset option in you camera so that
it uses continuous numbering. The menu settings will vary from camera model to camera model but
will look something like this:
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Canon PowerShot S2 IS menu showing the File number reset option turned off.
An alternative way to resolve this problem is to change the name of the downloaded files to ensure
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they are different. Prefixing the filename with the time will ensure images with the same filename but
taken at different times will be downloaded without any problems. Some suggested alternatives are
listed below:
e.g. A file taken at 13:07:20 on March 1, 2006 with an original filename stored by the camera of
IMG_0376.JPG
Filename string
in DLPro's
preferences
{o}
{t}_{o}
{d}_{t}_{o}
{d}_{t}_{r}

Name of downloaded file Comment

IMG_0376.JPG
130720_IMG_0376.JPG

Original filename written by camera
Original filename prefixed by the time it was
taken
060301_130720_IMG_037 Original filename prefixed by the date and date it
6.JPG
was taken
060301_130720_0376.
Date and time image was taken followed by
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You will also get this error if you are using the JPEG auto profile plug-in or the JPEG resolution plugin unless you select "Ignore file size check to allow for images modified after downloading" in
Downloader Pro's preferences. This is because these plug-ins add information to JPEG files which
changes the size of the downloaded file.
"Name clash"
This occurs when two different files on the memory card have the same download names. One
reason for this is when you specify a download filename such as {t} which names the files according
to the time they were taken. You may get a "Name clash" error if you try to name files this way and
your camera takes more than one shot per second. The easiest way to avoid this is to specify a
download filename which includes more information to ensure the filenames are unique e.g. you
might use {t}_{r} which puts the image number after the time.
If you have a Canon EOS-1D series camera (1D, 1Ds, 1D Mark II or 1Ds Mark II) or a recent Nikon
digital SLR and are downloading using a card reader you can use the tokens {r8}, {r85} or {r86}.
These read the image counter which is the total number of shots the camera has taken.
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"Time different"
This means that there is a file of the same name and size but with a different file timestamp is in the
download directory. The usual reason for this is the file has been modified after it has been
downloaded. Normally this is not a problem, but you should check that it is the same file before
erasing the memory card. The best way to avoid this problem is to download all your images before
modifying them in another app.

7

Filename and Directory tokens
This section lists the tokens that can be used to specify the download directory and filename. Please
see the section on "Using filename and directory tokens" for information on how to use tokens.

Shooting date and time tokens
{a}

Abbreviated weekday name

e.g. Fri
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{A}
{b}
{B}
{d}
{D}
{H}
{I}
{j}
{m}
{M}
{p}
{plc}
{P}
{s}
{S}

Full weekday name
Abbreviated month name
Full month name
Date in the form YYMMDD (equivalent to {y}{m}{D})
Day of the month (01 to 31)
Hour (00 to 23)
Hour (01 to 12)
Day of the year (001 to 366)
Month (01 to 12)
Minutes (00 to 59)
am/pm indicator (upper case)
am/pm indicator (lower case)
Quarter: Jan-Mar=1, Apr-Jun=2, Jul-Sep=3, Oct-Dec=4
Date/time subsecond timing (only available with some
cameras e.g. Nikon DSLRs and recent Canon DSLRs
when using a card reader e.g. 40D and 1DMk3)
Seconds (00 to 59)
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e.g. Friday
e.g. Jun
e.g. June
e.g. 040611 for June 11, 2004

e.g. 06 for June
e.g. PM
e.g. pm
e.g. Q{P} gives Q2 for June
e.g. 56
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{t}
Time in the form HHMMSS (equivalent to {H}{M}{S})
{epoch} Time in seconds since January 1, 1970 (10-digit number) e.g. 1159805283 for 17:08:03 on
Oct 2, 2006
{epoch3 Time in seconds since January 1, 1970 expressed in
e.g. J6INHF for 17:08:03 on Oct 2,
6}
base 36 using the characters 0-9 and A-Z (6 character
2006
string)
{W}
Week number (00 to 53). Week 01 is the first week of the e.g. 00 for Tuesday 1st January
year containing a Monday
2013
{WI}
ISO week number (00 to 53). Week 01 is the first week e.g. 01 for Tuesday 1st January
of the year containing a Thursday.
2013
Note: This doesn't strictly adhere to the ISO standard
because it returns 00 for Sun 2 Jan 2005 when it should
return 53. The full ISO week date for Sun 2 Jan 2005 is
actually 2004-W53-7.
{IWD} Full ISO week date in the form year, week number, day e.g. 2013-W01-2 for Tuesday 1st
number
January 2013
{x}
Date representation for locale
e.g. 06_11_04 for June 11, 2004
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{X}
{y}
{Y}
{z}
{Z}
{#c}
{#x}
{1}
{2}
{3}
{4}
{5}

177

Time representation for locale
e.g. 14_39_29
Year without century
e.g. 04 for 2004
Year with century
e.g. 2004
Time zone name
e.g. GMT Standard Time
Time zone offset wrt UTC
e.g. +0100 for GMT during DST
Long date/time representation for locale (IPTC data only) e.g. 29 December 2005 15:34:26
Long date representation for locale (IPTC data only)
e.g. 29 December 2005
Year 'now' in the form YYYY i.e. the download date
e.g. 2004
Month 'now' (01 to 12) i.e. the download date
Day 'now' (01 to 31) i.e. the download date
Year 'now' in the form YY i.e. the download date
e.g. 04 for 2004
Year less 3 hours in the form YYYY. This is useful when e.g. shots for a new Year's eve
shooting events which start in the evening and continue party on 31 December 2004 will
into early the next morning and you want to use the same return 2004 up to 3am on 1
date for the whole event. The tokens {5}, {6}, {7} and {8} January 2005.
return the date the image was shot less 3 hours. Using
these tokens will ensure that images shot before 3am will
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{6}
{7}

use the previous day's date.
Month less 3 hours (01 to 12). Please see {5} for full
description
Day less 3 hours (01 to 31). Please see {5} for full
description

Shooting data tokens
{c}
{C}
{e}
{E}

Camera serial number (Canon EOS cameras and
recent Nikon digital SLRs only)
Canon EOS-1D/1DS style camera serial number
File extension (without the '.')
File type based on the file extension. Evaluates to
"JPG" for .JPG, .JPE and .JPEG extensions and to
"RAW" for all other extensions. Suggested use: To
separate JPEGs and raw files when shooting in

e.g. JPG for IMG_4567.JPG
e.g. Set download directory to
D:\Photos\{E} and JPEGs will
downloaded to: D:\Photos\JPG and
all other files will be downloaded
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{E1}
{E2}
{E3}
{E4}
{E5}
{E6}
{E7}

raw+JPEG mode.
to: D:\Photos\RAW
Same as {E} except it evaluates to an empty string for
JPEG files and "RAW" for other file types.
Same as {E} except it evaluates to "JPG" for JPEG
files and an empty string for other file types.
Same as {E} except it evaluates to an "JPG" for JPEG
files and "MOV" for other file types.
Same as {E} except it evaluates to an empty string for
JPEG files and "MOV" for other file types.
Same as {E} except it evaluates to "MOV" for movie
files and THM thumbnails and an empty string for other
file types.
Same as {E} except it evaluates to "RAW" for raw files
and an empty string for other file types.
Same as {E} except it evaluates to "movies" for movie
files and THM thumbnails and an empty string for other
file types.

© 2022 Breeze Systems Limited

179

180

Downloader Pro Help

{E8}

Same as {E} except it evaluates to an empty string for
movie files and THM thumbnails and "pictures" for
other file types.
{E9}
Same as {E} except it evaluates to "videos" for movie
files and THM thumbnails and an empty string for other
file types.
{f}
First 3 characters of image name
e.g. IMG for IMG_4567.JPG
{file[n-m]} Extract characters from the filename:
e.g. Using filename
{file[n-m]} returns characters n to m of the original
IMG_4567.JPG
filename {file[n]} extracts character n from the original {file[2-4]} gives MG_
filename
{file[3]} gives G
{file[n-]} returns the filename starting from character n {file[3-]} gives G_4567
{file[-n]} returns n characters starting from the end of {file[-6]} gives G_4567
the filename
{i}
ISO value read from the shooting data
{k}
ISO value read from the shooting data (same as {i}
except ISO 0 is returned as "Auto")
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{K1}
{K2}
{K3}
{o}

Lens focal length in mm
Aperture
Shutter speed
Image folder name when used in download directory,
original image name when used for filename

{O}
{q}

Owner string (Canon cameras only)
The number of the image folder

{Q}

Image folder name

{Q1}

Source folder pathname without drive name ({Q}
prefixed with \DCIM\ when downloading directly from a
Canon camera)
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e.g. 28
e.g. 5.6
e.g. 125 for 1/125 sec
e.g.
\DCIM\123CANON\IMG_4567.JPG
evaluates to: 123CANON when
used in the download directory
IMG_4567 when used in the
filename
e.g. 123 for images in
\DCIM\123CANON
e.g. 123CANON for images in
\DCIM\123CANON
e.g. \DCIM\456NIKON
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{Q2}

Source folder pathname relative to source folder
(same as {Q1} when downloading directly from a
Canon camera)
{Q3}
First character of source folder when downloading from
a card reader (i.e. the drive letter)
{readOnly Returns 'read_only' if file is read only or empty string e.g. read_only for a file that is read
}
otherwise
only
{readOnly Returns 'high' if file is read only or empty string
e.g. high for a file that is read only
1}
otherwise
{readOnly Returns 'high' if file is read only or 'low' otherwise.
e.g. low for a file which is not read
2}
Useful when important images are marked as
only
protected in the camera before downloading as it can
be used to sort them into high and low priority folders.
{r}
Image number
e.g. 4567 for IMG_4567.JPG
{r1}
Last digit of the image number. Useful when renaming e.g. 7 for IMG_4567.JPG
using the date and time and shooting at more than
1fps e.g. {d}_{t}_{r1}
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{r2}
{r3}
{r4}
{r5}
{r6}

{r7}
{r8}
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Last two digits of the image number. Useful when
e.g. 67 for IMG_4567.JPG
renaming using the date and time e.g. {d}_{H}{M}_{r2}
Last three digits of the image number
e.g. 567 for IMG_4567.JPG
Last four digits of the image number
e.g. 4567 for IMG_4567.JPG
Last digit of the folder number followed by the last four e.g. 34567 for IMG_4567 in folder
digits of the image number
123CANON
First digit of the folder number followed by the last four e.g. 14567 for IMG_4567 in folder
digits of the image number. This is useful for cameras 145CANON
where only the first digit of the folder number is unique
and the last two digits are the same as the first two
digits of the image number.
Same as {r6} but subtracts 1 from the first digit of the e.g. 04567 for IMG_4567 in folder
folder number. This is to allow numbering from 00001 145CANON
for cameras which start numbering folders from 100.
Image or shutter activation counter. Only available
e.g. 123
when downloading images using a card reader from
the following cameras: Canon
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{r85}
{r86}
{n1}
{n2}
{n3}
{n4}
{N1}
{N2}

EOS-1D/1Ds/1DMk2/1DsMk2 and Nikon DSLRs from
the D70 onwards
Same as {r8} but padded with leading zeroes to give a e.g. 00123
5-digit number
Same as {r8} but padded with leading zeroes to give a e.g. 000123
6-digit number
Download sequence number for this session only with Please see the notes below
no leading zeroes
As {n1} but padded with leading zeroes to give a 2-digit Please see the notes below
number
As {n1} but padded with leading zeroes to give a 3-digit Please see the notes below
number
As {n1} but padded with leading zeroes to give a 4-digit Please see the notes below
number
Date-based download sequence number with no
Please see the notes below
leading zeroes
As {N1} but padded with leading zeroes to give a
Please see the notes below
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{N3}
{N4}
{l}
{la}
{l2}
{l3}
{l4}
{L}

2-digit number
As {N1} but padded with leading zeroes to give a
3-digit number
As {N1} but padded with leading zeroes to give a
4-digit number
"Uniqueness" number evaluates to the lowest number
required to give a unique download filename or empty
string if not required
Same as {l} but with the number expressed using the
letters 'a' to 'z' e.g. 1='a', 2='b', 26='z', 27='aa', 28='ab'
2-digit "uniqueness" number padded with leading
zeroes
4-digit "uniqueness" number padded with leading
zeroes
4-digit "uniqueness" number padded with leading
zeroes
Same as {l} but starts numbering from 1
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Please see the notes below
Please see the notes below
Please see the notes below
Please see the notes below
Please see the notes below
Please see the notes below
Please see the notes below
Please see the notes below
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{La}
{L2}
{L3}
{L4}
{seq#}
{seq#2}
{seq#3}
{seq#4}
{seq#5}
{seq#6}
{R}

Same as {L} but with the number expressed using the
letters 'a' to 'z' e.g. 1='a', 2='b', 26='z', 27='aa', 28='ab'
Same as {l2} but starts numbering from 1
Same as {l3} but starts numbering from 1
Same as {l4} but starts numbering from 1
Download sequence number
As {seq#} but padded with leading zeroes to give a
2-digit number
As {seq#} but padded with leading zeroes to give a
3-digit number
As {seq#} but padded with leading zeroes to give a
4-digit number
As {seq#} but padded with leading zeroes to give a
5-digit number
As {seq#} but padded with leading zeroes to give a
6-digit number
"Downloads today". This token keeps a count of the

Please see the notes below
Please see the notes below
Please see the notes below
Please see the notes below
Please see the notes below
Please see the notes below
Please see the notes below
Please see the notes below
Please see the notes below
Please see the notes below
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{T1}
{T2}
{T3}

number of downloads performed today and can be
used to number each download to avoid duplicate
filenames.
Camera model name starting from the first word
containing digits
Same as {T}, but '-' are treated as spaces
Full camera model name
First word of camera model name containing digits

{T4}

Same as {T3}, but '-' are treated as spaces

e.g. 1DS for Canon EOS-1DS
e.g. Canon EOS 5D
e.g. DC4800 for KODAK DC4800
ZOOM DIGITAL CAMERA
e.g. 1D for Canon EOS-1D Mark II

{T5}

Last word of camera model name containing digits

e.g. 30D for Canon EOS 30D

{T6}

Same as {T5}, but '-' are treated as spaces

e.g. 1Ds for Canon EOS-1Ds Mark
II

{T8}

Uses the value defined in Camera name mapping
preferences

{T}
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e.g. 30D for Canon EOS 30D
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(defaults to {T1} if no mapping is defined)
{T9}
{v}
{V}

Uses the value defined in Camera name mapping
preferences
(defaults to {T1} if no mapping is defined)
Camera model name starting from the first word
containing digits
(same as {T1} for compatibility with BreezeBrowser)
Full camera name
(same as {T2} for compatibility with BreezeBrowser)

Other tokens
{J}
{u}

Job code
"My Pictures" folder (not all versions of Windows support e.g. C:\Documents and
this)
Settings\chris\My Documents\My
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{U}

"My Documents" folder

{vol}

Disk volume name (card readers and disk drives only)
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Pictures
e.g. C:\Documents and
Settings\chris\My Documents
e.g. EOS_DIGITAL

Download Sequence Numbers
Downloader Pro can allocate a download sequence number to images which can be used to number
images as they are downloaded. For the {n} and {N} tokens the sequence is allocated in time/date
order with the oldest image starting at 1 each time Downloader Pro is run. The {seq#} tokens continue
numbering from the last image downloaded and can be used for the continuous numbering of images
even if Downloader Pro is closed and run again.
The sequence number can accessed using the tokens {n1}, {n2}, {n3} and {n4} to give 1-digit, 2-digit,
3-digit or 4-digit numbers respectively e.g. {n3} will give numbers like 001, 002, 003 etc.
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The tokens {N1}, {N2}, {N3} and {N4} work in a similar way but the numbering is reset to 1 for each
new date e.g. images from Jan 1 will start from 1 and {N2} would give values like 01, 02, 03 and
images from Jan 2 would also start from 01.
These tokens should be used in conjunction with the date tokens to avoid duplicate filenames e.g. set
the filename to "{d}_{N3}".
Warning: Please use the {n} and {N} tokens carefully. They are fine if you only ever download one
set of images at a time but may result in duplicate filenames if you download several memory cards
on the same day.
The tokens {seq#}, {seq#2}, {seq#3}, {seq#4}, {seq#5} and {seq#6} give 1-digit, 2-digit, 3-digit, 4-digit,
5-digit or 6-digit numbers respectively. Downloader Pro keeps a record of the sequence number
between sessions and will continue numbering where it left off the next time it is run. The initial value
for the sequence number can be set in Preferences
Please note that if the same memory card is downloaded twice the second set of images will be given
new sequence numbers resulting in two copies of each image.
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Uniqueness Numbers
Downloader Pro can add a "uniqueness number" to the download filenames to avoid duplicate
filenames. The {l} tokens evaluate to an empty string if the filename is already unique otherwise they
are set to the lowest number that will give a unique filename. The {L} tokens are similar to the {l}
tokens except that they always evaluate to a number.
Tip: Prefix {l} with a space, dash or underscore if you wish to visually separate the uniqueness
number from the rest of the filename. If {l} evaluates to an empty string the trailing space, dash or
underscore will be removed (see the {d} {l3} example below)
For example suppose files are named using the date they were taken (e.g. {d}) and three images
were taken on the same day. This would result in three different source files all having the same
download filename e.g. 20051228.jpg. This would produce duplicate filenames if more than one
image was taken on the same day. The duplicate filenames can be avoided by using one of the
uniqueness number tokens:
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Source filename {d} value
IMG_1234.JPG 20051228.JP
G
IMG_1235.JPG 20051228.JP
G
IMG_1236.JPG 20051228.JP
G

{d}{l} value
{d}{la} value {d}_{l3} value
20051228.JPG 20051228.JPG 20051228.JPG
200512281.JP
G
200512282.JP
G

20051228a.JP
G
20051228b.JP
G

{d}_{L} value
20051228_1.JPG

20051228_001.JP 20051228_2.JPG
G
20051228_002.JP 20051228_3.JPG
G

Please Note: Downloader Pro only compares the download filenames with the other files on the
source drive. It does not check the names of files already in the download directory because this
would make it impossible for Downloader Pro to keep track of which files have already been
downloaded.
The images are sorted into timestamp order (followed by alphabetical if two images have the same
timestamp) before allocating the uniqueness numbers. This additional sorting may cause Downloader
Pro to run slowly when downloading large numbers of images.
The uniqueness tokens can only be used to define the download filename and shouldn't be used to
specify the download directory.
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Tokens for modifying strings
The tokens below can be used to modify tokens or strings:
Token
{left,n,str}
{mid,n,m,str}

{right,n,str}
{field,n,str}
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Description
Extracts the first n characters from str
(which can be a string or token).
Extracts m characters starting from the
n'th character from str (which can be a
string or token).
Extracts the last n characters from str
(which can be a string or token).
Extracts the nth field from str. Fields are

Example
{left,4,{T2}} for an image taken with a
Nikon Z7 will give: Niko
{mid,1,4,{T2}} for an image taken with a
Nikon Z7 will give: ikon
{right,3,{T2}} for an image taken with a
Nikon Z7 will give: 300
{field,1,IMG_0001.JPG} will give: IMG
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{field2,n,ch,str}
{first,str}
{last,str}
{default,str1,str2
}
{if,test,str1,str2}

{compare,str1,st

separated by space, period, hyphen,
slash, backslash or underscore characters
Extracts the nth field from str using the
character ch as the field separator
Extracts the first word from str (which can
be a string or token).
Extracts the last word from str (which can
be a string or token).
Returns str1 unless it is an empty string in
which case it returns str2 (str1 and str2
can be strings or tokens).
Returns str1 if test is not an empty string
else returns str2 (test, str1 and str2 can
be strings or tokens)
Returns 1 if str1 is the same as str2 else

{field2,2,-,one-two-three} will give: two
{first,{T2}} for an image taken with a
Nikon Z7 will give: Nikon
{last,{T2}} for an image taken with a
Nikon Z7 will give: Z7
{default,{J},none} returns the job code if
defined and defaults to "none" if it is not
defined.
{if,{E1},JPEG file,not a JPEG} returns
"JPEG file" if the file has a JPEG file
extension else returns "not a JPEG"
{compare,photo,photo} returns 1,
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r2}

{compare,photo,image} returns empty
string
{contains,str1,st Returns 1 if str1 contains str2 else returns {contains,photo,to} returns 1,
r2}
an empty string
{contains,photo,camera} returns empty
string
{upper,str}
Converts str to upper case
{upper,{B}} for a photo taken in June
gives: JUNE
{lower,str}
Converts str to lower case
{lower,{B}} for a photo taken in June
gives: june
{capitalize,str) Converts str to lower case and capitalizes {capitalize,john} gives John
the first letter
{field,n,str}
Extracts the nth field from str (fields are {field,2,{o}} for filename IMG_1234.jpg
separated by space, ., - or _)
would give 1234
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Tokens for country code/name lookup
The tokens below can be used to convert between ISO-3166 alpha2 and alpha3 country codes and
names:
Token
Description
{cc1,code} Looks up the country name given the ISO-3166
alpha2 or alpha3 country code (code can be a
string or token).
{cc2,alpha Looks up the ISO-3166 alpha2 country code
3}
given the alpha3 code (alpha3 can be a string
or token).
{cc3,alpha Looks up the ISO-3166 alpha2 country code
2}
given the alpha3 code (alpha2 can be a string
or token).

Example
{cc1,USA} gives United States

{cc2,DEU} gives DE

{cc3,GB} gives GBR
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Tokens can be combined as in the example below:
Suppose the job code consists of a four digit job number followed by a 2 character country code and
the client's name
e.g. "1234GB Jones" and "1235US John Doe Inc."
{J} gives the full job code - "1234GB Jones" or "1235US John Doe Inc."
{left,4,{J}} gives the job number - "1234" or "1235"
{mid,4,2,{J}} gives the 2 character country code - "GB" or "US"
{cc1,{mid,4,2,{J}}} gives the country name - "United Kingdom" or "United States"
{cc3,{mid,4,2,{J}}} gives the 3 character country code - "GBR" or "USA"
{mid,7,100,{J}} gives the client name - "Jones" or "John Doe Inc."
Or used with the geonames place name tokens e.g. Geonames returns a two character country code
and this can be converted to a three character country code for use in IPTC/XMP data using
{cc3,{geonames_countryCode}}
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Defaulting to the GB country code when GPS data or geonames data is not available:
{default,{geonames_countryCode},GB}

8

Release Notes
Supported Platforms
Downloader Pro will run on Windows 11, Windows 10, Windows 8
3 May 2022: v2.6.3
1. Added support for downloading GoPro raw files with .gpr file extension
2. Added support for downloading Canon raw video files with .crm file extension
3. Added {compare,str1,str2} and {contains,str1,str2} tokens for comparing strings
4. Added {field,n,str} and {field2,n,ch,str} tokens for extracting parts of strings
5. Fixed an issue reading subsec times from Canon CR3 raw files
23 October 2020: v2.6.2
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1. Added support for Canon EOS 850D/Rebel T8i, Canon EOS R5, Canon EOS R6 and Canon EOS
1D-X Mark III
2. Fixed an issue updating the owner string, artist and copyright information for recent Canon
cameras
3. Minor improvements to the option to prompt for the job code each time Downloader Pro is run
15 January 2020: v2.6.1
1. Added support for Canon EOS 90D, Canon EOS M6 Mark II, Canon EOS M200, Canon
PowerShot G5 X Mark II and Canon PowerShot G7 X Mark II
2. Added the option to disable PTP transfers to allow raw files to be downloaded from card readers
when using Windows 10
3. Improved display of thumbnails from Canon CR3 raw images when using a card reader
27 May 2019: v2.6
1. Added support for Canon EOS RP, Canon EOS 250D/Rebel SL3 and Canon PowerShot SX70HS
2. Added support for Canon CR3 format raw files in the Adobe DNG converter plug-in
3. Fixed an issue with registering for Windows AutoPlay when installing Downloader Pro
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19 December 2018: v2.5
1. Added support for the new Canon CR3 raw file format
2. Added support for Canon EOS R, Canon EOS M50, Canon EOS 6D Mark II, Canon EOS
200D/Rebel SL2, Canon EOS 1500D/2000D/Rebel T7, Canon EOS 3000D/4000D
29 June 2017: v2.4.1
1. Added support for Canon EOS 77D, Canon EOS 800D/Rebel T7i, Canon EOS 1300D/Rebel T6,
Canon EOS 5D Mark IV, Canon EOS-1D X Mark II
2. Added options for improved display on high DPI screens
3. Now uses new installer to fix problems installing the software on large hard disks
14 August 2015: v2.4
1. Added support for Canon EOS 5Ds, Canon EOS 5Ds R, Canon EOS 7D Mark II, Canon EOS
760D/Rebel T6s and Canon EOS 750D/Rebel T6i
2. Added {file,n,str} token to make it easier to extract values from strings
3. Fixed a problem caused by images which contain invalid time information in the EXIF DateTime
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field e.g. an invalid time value such as 24:40:25
4. Fixed a problem reading the camera model name from the EXIF data of some Sony cameras
2 June 2014: v2.3.1
1. Fixed a problem with Geonames place name lookup
26 May 2014: v2.3
1. Added support for direct downloading from the Canon EOS 1200D/Rebel T5
2. Improved support for downloading from PTP devices such as smart phones
3. Updated support for Geonames place name lookup to include a username
28 November 2013: v2.2.9.3
1. Added support for direct downloading from the Canon EOS 70D, Canon EOS 700D/Rebel T5i
and Canon EOS 100D/Rebel SL1
2. Added {if,test,str1,str2} token for conditional string replacement
3. Added {vol} token for reading the disk volume name when downloading from a card reader or
disk drive
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25 January 2013: v2.2.9.2
1. Added support for Phase One IIQ raw files
2. Added support for direct downloading from the Canon EOS M and Canon EOS 6D
3. Added {WI} token for ISO week number and {IWD} token for full ISO week date
2 August 2012: v2.2.9.1
1. Fixed a problem where only the first image was listed when downloading from a memory card
reader
2. Improved reading of EXIF shooting from 5D Mark III images when downloading from a card
reader so that the serial number is available when using camera name mapping
26 July 2012: v2.2.9
1. Added support for direct downloading from the Canon EOS 600D/Rebel T3i, Canon EOS
650D/Rebel T4i, Canon EOS 1100D/Rebel T3, Canon EOS 5D Mark III and Canon EOS-1DX
2. Added support for EXIF 2.3 shooting data (OwnerName and SerialNumber)
3. Added support for .3GP and .MXF video files
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17 November 2010: v2.2.8
1. Added support for direct downloading from the Canon EOS 60D
2. Added tokens for converting strings to upper or lower case
3. Added {E9} token which returns the value 'videos' for movie files
4. Added support for .MP4 video files and .MPO 3D files
5. Improved support for reading shooting data and displaying thumbnails for MOV movie files from
recent Canon DSLR cameras
10 June 2010: v2.2.7
1. Added the following tokens for distinguishing between picture and movie file types: {E5}, {E6},
{E7}, {E8}
2. Added support for Samsung SRW raw files
3. Added support for downloading MTS video files
4. Updated software protection libraries to fix problems with Downloader Pro crashing at startup on
some systems
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15 March 2010: v2.2.6
1. Added support for reading MPO files from Fuji FinePix REAL 3D W1 cameras
2. Now displays thumbnails when downloading directly from recent Canon EOS digital SLRs
3. Added support for downloading directly from the Canon EOS 550D/Rebel T2i
4. Fixed a problem listing previously deleted files when downloading directly from Canon EOS
digital SLRs
28 December 2009: v2.2.5
1. Added {E3} and {E4} tokens to help sort movie files to different subfolders
2. Added a workaround to fix a crash caused by Comodo Firewall on Windows Vista SP2
3. Added support for downloading directly from the Canon EOS 7D and Canon EOS-1D Mark IV
4. Now downloads THM thumbnail files when downloading movie files directly from Canon EOS
cameras. Also handles the downloading of very large movie files (i.e. 2GB and larger) directly
from Canon EOS cameras.
5. Improved performance when downloading directly via USB from recent Canon DSLR cameras
6. Fixed a problem reading shooting data from iPhone images
7. Now ignores filenames starting with . (from folders copied from Mac computers) which can cause
Downloader Pro to crash
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14 July 2009: v2.2.4
1. Now allows tokens to be used in IPTC keywords
2. Added support for downloading directly from the Canon EOS 500D/Rebel T1i
3. Fixed a problem displaying the status of files larger than 2GB which have been downloaded
successfully
4. Improved protection against corrupted JPEG image files
5. Added support for downloading video files with .mts file extension (no detailed shooting data, only
date and time based tokens)
6. Added the ability to set the artist and copyright fields for recent Canon cameras that support this
7. Added compatibility options for the DNG converter plug-in to allow DNG files to be created which
are compatible with older versions of Photoshop, Lightroom and other software
11 February 2009: v2.2.3
1. Added support for downloading very large files e.g Canon EOS 5D Mark II video files in excess of
2Gb in size
2. Added optional prompt to enter camera name mapping values when a new camera is detected
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3. Fixed a problem reading the camera serial number from Nikon NEF files
4 November 2008: v2.2.2
1. Added support for downloading directly from the Canon EOS 50D and Canon EOS 5D Mark II
2. Added support for Nikon NRW raw files (from the Coolpix P6000)
3. Fixed a window sizing problem after closing Downloader Pro with the window maximized
8 October 2008: v2.2.1
1. Added command line option to select user profile at startup
2. Fixed a problem looking up place names using www.geonames.org when the PC's regional
settings are set to use comma as the decimal separator
3. Fixed a possible crash when saving IPTC from the IPTC editor window
12 September 2008: v2.2
1. Added support for user profiles
2. Added place name lookup using GPS data and www.geonames.org
3. Added {cc1,str}, {cc2,str} and {cc3,str} tokens for converting between two and three character
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country codes and looking up country names
4. Added the following new tokens for extracting parts of strings: {left,n,str}, {mid,n,m,str},
{right,n,str}, {first,str}, {last,str}, {default,str1,str2}
5. Fixed problems geo-tagging JPEGs which already contain a GPS IFD and added diagnostic
"Check GPS data" right click option
6. Now reads camera serial number from images from recent Nikon digital SLRs (e.g. D300, D3,
D700).
8 February 2008: v2.1
1. Added support for downloading directly from cameras using PTP protocol
2. Added options to the Backup plug-in to backup all images, JPEGs only or non-JPEGs only
3. Fixed a problem writing GPS data to JPEGs from recent Nikon cameras
4. Added {readOnly} tokens to allow important images marked as 'protected' to be downloaded into
separate folders
4 October 2007: v2.0.4
1. Added support for Canon EOS 40D
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2. Now reads subsecond timing from recent Canon cameras when using a card reader (e.g. 40D
and 1DMk3)
3. Added support for more sentences in NMEA GPS track logs
21 August 2007: v2.0.3
1. Added an option in preferences to preserve the read-only status of images when downloading
2. IPTC/XMP keyword catalogs now support synonyms
3. No longer requires DEP (data execution protection) to be disabled when running on Windows
Vista
4. Added support for downloading directly from Canon EOS cameras on Windows Vista (doesn't
support older models which do not have Vista drivers)
5. Added support for downloading from the new Canon EOS-1D Mark III
6. Added support for downloading Mamiya ZD raw files
7. Now reads NMEA format GPS track logs with .txt, .nma and .gps file extensions
16 May 2007: v2.0.2
1. More robust handling of NMEA sentences with empty fields
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2. Now writes XMP sidecar files for Minolta raw format files
3. Fixed problems writing XMP GPS data in locales which use comma for the decimal separator
4. Fixed a problem with the auto AdobeRGB setting in the JPEG auto-profile plug-in with JPEGs
from some cameras
5. Fixed a problem with adding data and then auto-rotating JPEGs with images from some
cameras
30 April 2007: v2.0.1
1. Added support for GPX format GPS track log files
2. Added support for Garmin ForeTrex XML track logs
3. Added support for Magellan NMEA track logs which use private $PMGNTRK sentences
4. Extended Google Earth and Google Maps track log support to include locales which do not use '.'
(period/full stop) as the decimal symbol
5. Thumbnail display now generates the thumbnail from the JPEG file if available when displaying
".RAW" raw files from Leica and Panasonic cameras
6. Now automatically skips the file size check for JPEG images when GPS geo-tagging is enabled
to avoid misleading "size different" file size errors after downloading
7. Restored the "Register for AutoPlay" menu options when running on Windows XP
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8. Added support for downloading Sony ARW raw files
9. Fixed problems writing GPS data to JPEG shooting data from some camera models
28 March 2007: v2.0
1. New thumbnail display making it easier to identify the contents of a memory card and select
images for downloading
2. New automatic GPS geo-tagging of JPEG and raw images as they are downloaded using GPS
track log data from devices such as the Sony GPS-CS1. Also optionally creates track log files
which can be viewed in Google Earth or Google Maps
3. Added date based job codes making it easier to download memory cards containing different
subjects shot on different days
4. Added support for IPTC/XMP metadata for compatibility with apps like Photoshop and
BreezeBrowser Pro
5. Backup plug-in now supports one or two backups allowing two backup copies of images to be
made as images are downloaded
6. New sequence numbering tokens added to make it easier to have continuous numbering when
downloading images from multiple memory cards.
7. New more flexible token format to avoid possible conflicts with certain sequences (automatically
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updated from the old format when Downloader Pro v2 is run)
8. Added support for Hasselblad raw files
9. Settings can now be saved to a Windows registry file for backup purposes or when copying
settings to another PC
10. Now works with AutoPlay on Windows Vista (allowing Downloader Pro to be launched
automatically when a memory card is placed in a card reader)
4 May 2006: v1.9
1. Added support for downloading from the Canon EOS 30D
2. Added BreezeBrowser Pro style tokens for extracting shooting data from images for inclusion in
the IPTC data
3. Added auto sRGB/AdobeRGB color profile selection based on the shooting data in the image to
the JPEG auto profile plug-in
10 February 2006: v1.8.1
1. Minor update to fix a problem reading the shutter activation count (%r8 token) from images from
Nikon digital SLRs. Also fixed a problem writing the values of some "numbered" tokens to IPTC
data.
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7 February 2006: v1.8
1. Added new DNG plug-in to automatically convert raw files from most cameras to Adobe's DNG
format (requires Adobe's free DNG converter software)
2. Updated to read shooting data from the Nikon D200
3. Additional tokens added to generate unique download filenames
4. Improved interface for setting up camera name mappings
5. Added support for Sony R1 raw files
14 September 2005: v1.7
1. Added new backup plug-in
2. New option to automatically synchronize the clocks of Canon cameras with the PC's clock
3. Additional tokens added to read lens, shutter and aperture information from image shooting data
4. Added support for Adobe DNG files
3 December 2004: v1.6
1. Stores the last 12 download paths and job codes
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2. Added token display window
3. Added %T9 token for more flexible camera name mapping
4. Added support for Konica Minolta raw files
18 October 2004: v1.5
1. Added support for downloading directly from Canon EOS 20D and 1D Mark II cameras
2. Added new tokens which return the date offset by three hours to avoid a date change when
shooting late at night after midnight
26 July 2004: v1.4:
1. Added %R "Downloads Today" token
2. Improved setting of camera data for Canon PowerShot cameras
3. Added support for Kodak and Sigma raw files
4. Now stores IPTC data in THM thumbnail files when available
22 April 2004: v1.3:
1. Can now display thumbnails when downloading from card readers
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2. Added %E token to allow raw and JPEG files to be separated
3. Added camera name mapping function
4. Added new directory maker plug-in
8 November 2003: v1.2
1. Now supports the downloading of raw files from Fuji, Pentax and Minolta cameras
2. Added %r1, %r2 and %r3 tokens for extracting parts of the image file number
3. Ability to set Canon EOS 300D/Digital Rebel flash exposure correction added to the camera
settings dialog
22 July 2003: v1.1
1. Now supports downloading from Canon cameras which use PTP e.g. Canon PowerShot G5,
S400, S50, A300, A60 and A70
2. Additional tokens added for extracting camera model names
3. Reads subsecond timing from shooting data
12 May 2003: v1.0
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1. First release of Downloader Pro

© 2022 Breeze Systems Limited

215

